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INTRODUCTION 
 
IMPORTANT 
The product must be installed correctly before used in clinical environment. Follow the 
instructions in the Installation instructions included with the product. 
 
If any serious incident should occur in relation to the device this should be reported to  
Unident and Competent Authority. 
 
The product may only be used in accordance with its intended use.  
 
INTENDED USE 
Onepix® is a software package developed by Unident AB for use in acquiring, 
displaying, and manually manage digital dental x-ray and video images.  
It provides a user interface so that the operator may acquire images such as digital x-
ray sensors and dental video cameras. 
 
The computer which runs the Onepix® software serves as the tool through which 
patient information is entered, image acquisition is initiated, and acquired images are 
viewed, managed, stored, and retrieved. 
 
Onepix is intended to be used by dental health professionals. This includes dentists, 
dental nurses, dental hygienists and/or dental radiologists. The intended patient 
population does not interact with the device at any point. 
 
INTENDED PATIENT POPULATION 
The intended patient population is patients of all ages who need oral X-ray examination 
or documentation of oral conditions. 
 
QUALIFICATION AND FACILITIES 
Onepix is intended to be used by dental health professionals. This includes dentists, 
dental nurses, dental hygienists and/or dental radiologists. No specific Onepix training 
is required for usage. 
 
Onepix is intended to be used in Dental practices or similar clinical environments. 
 
INDICATION FOR USE 
The indication for the use of Onepix is when there is a need to manage images for oral 
diagnostics, before selecting action and documentation of oral conditions. The Onepix 
user interface enables trained dental professionals to receive, store, transmit, print and 
analyze images to diagnose, plan treatments and follow up on oral conditions. 
 
This is usually done in the following situations: 

 When diagnosis cannot be determined by clinical examination only, or when 
suspected diagnosis requires radiographic verification or photo documentation. 

 For treatment planning to determine anatomy and suitable procedure. 
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 Checkups during treatment, such as radiographs to verify the root canal 
preparation depth, or implant component fit. 

 Post-treatment follow-up, for example analysis of root filling. 
 When follow-up of a physiological or pathological process, such as healing or 

the progress of the disease, is needed. 

CLINICAL BENIFITS 
The following clinical claims and benefits are identified for Onepix: 
 The advantage of digital technology enabled by Onepix is that the radiographs 

appear on the screen immediately after loading, within three seconds. 
 Unlike manual processing, there is no need to use chemicals to produce the images. 
 With Onepix, all the clinic's images can be easily collected in one system. 
 Onepix is an open system, which means that it works with all different sensors with 

full integration to most of the Scandinavian market's X-ray products and patient 
examination systems. 

 Modern user interface with smart menues that give the user a more efficient way 
of working and an improved user experience. 

 
 

 
Warning 
Connected devices must be interconnected, set up and tested to work as intended and to 
make the best use of Onepix's features. Onepix is part of a chain of products (external 
entities) that depend on each other for them to work together. There is a risk that your X-
rays will not be optimal if you do not have the right settings! 
 

 
 
CE MARKING 
Onepix is a software product according to MDCG 2019-11 and processes data with a 
medical purpose. 
 
Since Onepix is a software, has a medical purpose and is used to diagnose and monitor 
oral conditions, Onepix qualifies as a medical device according to MDR (EU) 2017/745. 
 
Onepix is a CE marked product. Unident is certified by Intertek Certification AB 
according to EN-ISO 13485:2016 Quality Management Standard. Unident is also 
certified according to SS-EN-ISO 9001:2015 Quality Management Standard and SS-EN-
ISO 14001:2015 Environmental Management Systems. 
 
Onepix meets DICOM standards, which are maintained by an international committee 
to achieve compatibility and improve workflow and efficiency between image 
processing systems and other information systems in healthcare. 
 
Onepix is designed and tested for use with compatible hardware devices. The list for 
compatible hardware is in the Onepix Installation section. 
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LICENSING ONEPIX 
Onepix is made available to the user through two different subscriptions as explained 
below. 
 
Onepix Cloud Organization – This subscription is required per organization and enables 
a unique Onepix instance for the organization but does not allow usage. 
 
Onepix Cloud User - This subscription allows one (1) user to use Onepix without 
restrictions. 
 
Onepix Local Viewer – Here you can only open exams, but not create new ones.  This is 
suitable for use on an office computer, reception computer etc.. 
 
Onepix Local Standard – This subscription has full functionality and allows acquisition 
from all compatible products. 
 
 

 
Warning 
Do not acquire any dental images in Demo mode unless you have ensured that you have a 
software that can display DICOM images after the function has ended! 
 

 
 
ONEPIX HELP RESOURCES 
The HELP button/function and user manual is in the the top right of the program. 
To read more about Onepix go to www.onepix.se 
 
For telephone support, contact Unident AB on tel. 0346-732 450 eller e-mail 
support@unident.se 
 
 
APPLICATION GROUP ICONS 
The following icons represent various software components that are installed together 
with the Onepix software. Additional items may apply when new Onepix applications 
and drivers are installed. 
 

Icon Description 

 
OnepixClient – application for network clients or standalone workstations 
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OnepixAutomation – Enables the launch of OnepixClient with parameters 

 
Onepix Admin – helps with managing the information in your Onepix database  

 
Onepix Help - Opens Onepix HTML Help 

 
Onepix Settings 

 Reference Number (Item Number) 

 
Refer to Instructions for Use 

 

 Manufacturer, contact details 
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GET TO KNOW ONEPIX 
 
This section provides a brief review of the Onepix User Interface. To learn more about 
the different parts and features, see sections on Exam View and Zoom View as well as 
Onepix Settings.  
 
LOGIN ONEPIX CLOUD 
The first time you launch Onepix Cloud for the day, you will get a login box where you 
can enter your login details. The login is saved all day on the PC that you log on to. If 
you start Onepix on another PC then you have to log in again. 

 
The login options available are Email, BankID, and Azure AD. Your login details are 
provided by your clinic administrator. 
 
 
WORK IN ONEPIX 
When you start working with Onepix, you will learn how to use two views, the exam 
view and the zoom view. Exam view and the zoom view have some things in common. 
Everything that is done in Onepix is saved automatically, i.e. you do not need to save 
any changes and you do not get a question if anything should be saved, but you can 
always undo changes as you will see when you read more about the features available 
in Onepix. The idea of this is to create a more user-friendly workflow. Below are the 
parts that are common to both exam and zoom view. 



 
 
 

 
 

8 
 

 

1. UPDATE FIELD: A row at the top of  the window that appears when there is an 
update available. Can be easily closed, by clicking on the text or via the cross on 
the far right, but will return after restarting the program. It is possible to turn 
off the automatic update request, see the onepix settings section for more 
information. 

2. PATIENT INFORMATION: At the top of the lightgray field, the patient 
information, such as social security number and name, is displayed.  This 
information is visible in both exam and zoom view. 

3. SETTINGS: On the far right of the same field as the patient information, there is  
an icon/button with gears that leads to Onepix settings. You can read more 
about the settings available in the Onepix Settings section. 

4. IMAGE PRESENTATION: The large bar in the middle displays exams, series, and 
images depending on whether you are in exam view or in zoom view. 

5. TOOLS AND FEATURES: All functions and tools used in Onepix can be found in 
the fields on the right and left of the exams/images. 

6. NOTE: To find out which version of Onepix you have, you can click on the 
Onepix icon at the top left. 
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EXAM VIEW 
When Onepix starts, the exam view appears first. In the beginning, only the light gray 
patient information field, at the top, is active. Here you can choose to create a new 
patient or do a search on the existing patient. 

 
Since Onepix is mostly opened from a patient management system, the selected 
patient's most recently taken images are showed directly instead, as in the picture 
below. 
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1. NEW / SWITCH PATIENT: If Onepix is not opened from a patient management 
system, you can create or search patients via these buttons. But the 
recommendation is to go through the patient management system, to get 
accurate patient information. 

2. NEW EXAM: New exam is created by clicking on the button new examinaion, at 
the bottom left.  

3. EXAMS AND SERIES: A list of tabs appear on the far left of the exam view in 
Onepix. Each gray tab with date corresponds to an examination for the patient 
in question. The most recent examination is at the top and the oldest at the 
bottom of the exam view. The green color indicates which exam appears in the 
slide presentation field in the center. For each exam, there may be one or more 
series, for example, one can have a bitewing and one or more apical series 
during the same exam session. If there are more exams than can fit on the 
screen, you can scroll down through the tabs to get to the desired exam.  But 
you can also scroll in the center. A new exam is only active for editing during the 
current day that the exam was created. When that day is over, the exam, all its 
series and images are locked for editing. The exam/series is locked when you 
see an icon with a padlock after the series name.  

 
4. IMAGE PRESENTATION AND IMAGE ACQUISITION: This field presents all series 

and exams in date order. This field was also used for image aqcuisition from a 
hardware such as a sensor or photo camera. In this field, you can directly 
rotate, detach image or read/write comments about the image.  You can also 
quickly zoom in part of the image by right-clicking and holding the mouse 
button image while moving to the area you are interested in. 

5. IMAGE MANAGEMENT: In this field, you will find functions for managing 
images. To select the images in the exam view, hold down the Ctrl key and click 
on the images. Then you select one of the functions that are in the field on the 
right, such as List images, Print, Export/Import images, etc. 

6. PLUGIN: This shows the plugins that are installed. Some examples of these are  
TWAIN, 3D Plugin etc. 

7. SEARCH: Here you can perform a quick search if you are looking for a certain 
kind of images. 

 

ZOOM VIEW 
If you doubleclick an image in the exam view, the image opens in zoom view where you 
can review and work on the image.  All changes made are automatically saved and are 
located under HISTORY in the right bar, where they can be easily removed by double-
clicking on Delete which is located to the right of each history entry. 
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1. BACK: The back button is used to get back to the exam view.  All changes made 
to the image will be saved automatically. 

2. TOOLS: Image tools are located to the left of the image. The tools contain 
graphical features such as brightness, contrast, orientation and magnification. 
There are also diagnostic tools such as pixel values, measurements and notes. 

3. IMAGE PRESENTATION: Here the image is displayed in the state and settings 
you select using the tools. 

4. ADJUST CONTROLS: Using these sliders, you can adjust the image presentation, 
such as increasing sharpness, light, and contrast, etc.  

5. HISTORY / POSITION / NAVIGATION: All changes to the image are displayed 
under HISTORY and can be easily removed by double-clicking on the text Delete. 
Under NAVIGATION, you see where in the series the image is located and under 
POSITION the dental status is displayed. 

 
Warning  
Marked teeth in the dental status are based on information added when loading the image. 
This may deviate from reality if the image was loaded in the wrong position in the series or 
if the necessary manual correction of the dental status was not made after exposure. 
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EXAM VIEW 
 
This section includes: 
 

- Patient management 

- Start a new Exam/Series 

- Create/Edit Layouts 

 Image management in examview 

- Compare/List images 

- Printing, Exporting and Importing Images , etc. 

 

PATIENT MANAGEMENT 
If a patient management system is used, it is usually linked to Onepix, which means 
that all patient data is automatically sent over from the patient management system.  If 
the patient management system is missing or for some other reason, the patient 
cannot be created from the patient management system, then you can use the built-in 
Onepix patient management functions. 

 
 
NEW PATIENT 
The patient's first name, last name and ID details should always be entered in the new 
patient dialog box. 

 

 
SEARCH PATIENT 
If there are previous examinations, you can retrieve the patient information by clicking 
the SEARCH PATIENT button. This opens the search box where you can search for 
patients First Name, Last Name and/or Patient ID.  Use only the space key if you want 
to search for, for example, both first name and last name, example: John Doe 1234 
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CLOSE PATIENT 
Closes the active patient and its examinations. 
 
 
HELP 
This option will open the help section of the Onepix application. The help files are 
designed to provide easy access to information about the various functions and options 
of the Onepix software.  
 
To open the help section, click the HELP button/text in the upper right corner of the 
application. 
 
 

EXAMS AND SERIES 
Starting with Onepix 2.0, exams and series are handled in a little different way than it 
did before.  An exam stands for an exam occasion. A series is a collection of pictures 
taken during the same occasion.  There can be several series in a single exam, such as a 
series with Panoramic Images and one with Bitewing. Exams and series appear in the 
left bar of the exam view with recent exams at the top of the list. An exam/series is 
active for editing during the first day that they are acquired, the next day the exam is 
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locked for all editing. This is visualized in the form of a padlock to the right of the 
Exam/Series. 

 

 

NEW EXAM 

 
The NEW EXAMINATION button is located at the bottom left. When you click on the 
button, you will get a dialogue, as shown in the image below. 
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Select a layout depending on the type of images to acquire and click START TAKING 
PICTURES. In this window, you also have the option to create a new layout, modify and 
select favorite layouts. You can also choose whether the examination should be on a 
different date. The setting for selecting a date is found under Onepix settings or via the 
security module. More about layouts and their management can be found under the 
EDIT OR CREATE LAYOUT section in this manual. 
 

NEW SERIES 

After you create the first exam, the text NEW SERIES appears under the current exam 
in the list on the left.  

 
 
To create more series, click the text NEW SERIES, select a layout and click START 
TAKING PICTURES. 
 

 
The new series dialog box looks the same as for new exam. The only difference is that a 
new series is created under the existing exam. 
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DELETE AN EXAM/SERIES 

 

You can delete a series/exam directly in the Onepix client by clicking on the recycle bin icon 
on the right side of the exam tab.  

 

When you click on the recycle bin icon then you will get a dialog box where you choose to 
confirm deletion or to cancel.  

 
 
Warning  
Only images without diagnostic value may be deleted according to applicable law. Exams 
deleted from the client can be restored through the Onepix Admin Tool. 
 

 
 

MOVE AN EXAMINATION/SERIES TO ANOTHER PATIENT 

 
You can move an examination/series from one patient to another by clicking on the 
arrow that appears on the right side of the examination tab. 
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Search patient where the examination/series is to be moved to. Select the patient and 
click SELECT. 
 

 
In this step, you confirm the move of images. To move single images from one patient 
to another, see the "Moving Items" section under Onepix Admin. 
 

 
Warning  
Exercise caution when an entire examination or series is moved to another patient. Check 
that the correct target patient is selected and also check that the exam or series was moved 
by opening the target patient in Onepix. 
 

 
 

EDIT OR CREATE LAYOUT 

Onepix has several preset series/layouts that are intended to cover the most common 
exam types. The layouts for intraoral X-ray are named in standard version: Horizontal 
bitewing, Vertical bitewing, Endo and Full mouth. It also includes layouts for photo, 
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intraoral camera images, panorama and scanner etc.  To get to the selection to edit or 
create new layout, you can click the NEW EXAM or NEW SERIES button in the exam list. 
 
The star icon that appears at the top right of the layout is used to sort layouts by 
favorites, click on a star and that layout will be placed in first place in the list, at the top 
left. The star then also changes color to green indicating that it is selected as a favorite 
layout.  To change settings for the specific layout, click the EDIT text below the layout.  

 
 
To create a new layout click on the create new layout button 

 
 
A dialogue with various settings as below will then come up.  

 

1. Start by typing a name for the layout. 
2. Select which modality the layout belongs to, such as Photo. 
3. The large black bar is where the layout is created and displayed.  Use the tools 

on the right to create/delete image objects, distribute or center 
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horizontally/vertically.  To see what the different icons do, you can place the 
mouse pointer over, then a text with explanation will appear. 

 
When you click on the plus sign, a position/frame is created in the black bar 
that looks like this:  

 
If you want to remove this box, click on it once to select it, and then click on the 
minus sign. To distribute or center frames, select the positions to be affected 
and click on the respective symbol.  

4. In this field, you can preset a frame with teeth. Click a frame to select it, and 
then click on the teeth it represents. 

 
5. Under Properties, you'll see the properties that exist for the selected frame. 

Here you can change settings, for the selected frame, such as Width, Height 
Rotate or Mirroring. Mirror horizontally is used, for example, if using a mirror 
when shooting a photo. 
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6. Click SAVE to save the layout with these settings. You can always change the 

layout afterwards if something goes wrong. 
7. Click CANCEL if you changed your mind. 

 
 

IMAGE MANAGEMENT 
 

 
All images are presented in the middle section of the Onepix exam view. The latest 
exam is presented first. To quickly get to a certain exam or series, you can go through 
the exam list on the left side and click on the date that is relevant. You can also browse 
directly in the middle section by scrolling with computer mouse. 
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SEARCH IMAGES 

 
At the top left, above the exam list, there is a search function. The idea  with it is to 
quickly find images that are interesting. The image below describes the different 
options available for the search function.  The search results are presented in the exam 
view with recently taken images at the top. 

 

1. QUICK SEARCH – Here are some of the most common searches. The idea is that you 
should be able to quickly get the images with just one click. 

2. SAVED SEARCH – You can create your own searches and save them. 

3. SEARCHTYPE – Here you select whether it is Exam, Series, or Images you are searching 
for. 

4. REMITTING CAREGIVER – If that information is in the pictures, you can search for a 
specific therapist. 

5. VIEWSET NAME – Here you can search by specific name of a series/layout or select 
the modality in the list. 

6. DATE – Here you can if the search should take place within a certain daterange. 

7. SELECT POSITION – Here you choose whether it is a certain tooth or position easily by 
clicking on the teeth to which the search applies. 

8. Here you choose whether to cancel the search, save or perform a search based on 
the criteria selected. 
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After you have done a search, onepix will display the search result in the exam view.  To go 
back to all exams, click on the BACK button at the top left. 

 

 

QUICK ZOOM 

Quick Zoom is a Onepix feature that "zooms" or enlarges images in an exam, making 
each image display in magnification. Quick Zoom can save you valuable time by not 
having to open each image separately to view it in magnification. 

 
To use Quick Zoom, you only need to right-click with the mouse cursor in an image in 
the exam view and hold down the mouse button, the image will then be displayed in an 
enlarged mode. Move the mouse pointer to move around in the image. Changing the 
size of the quick zoom window can be found under the section on Onepix settings. 
 

MOVE IMAGE / CHANGE POSITION 

If an image has ended up in a different box than what was intended, you can easily 
move the image by clicking on the image, holding down the left mouse button and 
dragging the image to another frame. 
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Before:  

After:  
 
If there already is an image in the box that you are moving to, these will change places. 

Before:  

After:  
 
Note that you can only move images in a series with today's date. Older series are 
locked for editing.  
 

MOVE IMAGES BETWEEN SERIES 

If you have created a series with bitewing horizontal, but regret it and want a bitewing vertical 
instead. Then you can create a new series by clicking on the text NEW SERIES 
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If you have already taken pictures in the series Bitewing Horizontal, but want to move 
these to the series Bitewing Vertical then you can easily just click on the image hold 
down the mouse button, drag and drop the image to the correct position. 
 

 
 
 
To remove a blank layout, one can click on the trash can icon to the right of the series. 

 
 
Confirm deletion if you are sure that you have selected the correct series to delete. 
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Warning  
Only images without diagnostic value may be deleted according to applicable law. Exams 
deleted from the client can be restored through the Onepix Admin Entry Tool. 
 

 

 

LIST IMAGES 

To compare/list two or more images, hold down the Ctrl key and click on the images to 
be compared.  The selected images will receive a green frame as an indication. If you 
want to compare all the images in a series then you can use the Ctrl+A keys to select all 
of them. 

 
 
Then click on any of the icons that appear in the right bar under COMPARE IMAGES. 
The different comparison options available from the left are: Multiple in squares, 
Horizontal, Vertical, Overlap. 
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This is what it can look like if you choose to compare the images horizontally. Fits well 
when comparing e.g. bitewing images. 

 
 
To close the images, you can either use the Esc key or you can click the cross on each 
image.  When choosing to compare images with practice patching, you can easily 
browse between the images by using the Page Up / Page Down keys 
 

PRINT 

The Print function can be used to print All images in the active exam or you can only 
print selected images. Select the images to be printed by holding down the Ctrl key and 
clicking on the images, the images will have a green frame as a highlight. 

 
 
If you choose to print all images, the entire examination will end up on a page with 
associated patient and examination information. If you choose to print the selected 
images, each individual image will end up on its own page. 
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EXPORT IMAGES 

The export feature can export either all images in an exam or only those that are 
selected. To highlight images hold down the Ctrl key and click on the images to export, 
the images will get a green frame as a highlight. 

 
 
Whether you choose to export all images or selected, you will get the following dialog 
box. Below the picture, the different selections are described step by step. 

 
 

1. Under Image Format there are the several choices to choose from. Export in 
DICOM format is preferred, but this requires that the recipient of the files has a 
software that can read DICOM files. 

 
2. Select a path for image export by clicking on the dots button, or type in a path 

such as C:\Temp 
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3. Under Export Options, you can choose whether to Anonymize the images, and 
you can also choose whether to burn patient information into the image. This is 
what an image can look like if you choose to both anonymize and burn the 
information in the image. 

 
 

4. Click Export, the destination folder will open in windows explorer and display 
the images saved.  

 

 
Warning  
To send images via email, the email must be encrypted to comply with the Patient Data Act. 
There are secure systems for this communication, such as C-tact Link. 
 

 
 

IMPORT IMAGES 

Imports images from files. Onepix program can import 8-bit and 12-bit black and white 
(in grayscale) images and 24-bit color images in several differentformats, such as.TIFF, 
BMP, PNG and JPG. 
 

 
 
In order to import images, you must be in a series with today's exam date. You can 
either choose to import images into an existing series or create a new series. If you are 
going to read from a memory card in a card reader, first insert the memory card, then 
click on the Import button. 
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1. Browse for images from a folder on disk. If you are reading from a memory card 
then the images will be presented instantly without you having to click on 
anything. 

2. If you want to label these images with a comment, do so here. 
3. Select the compression rate. Most often only done the first time, previous 

selections are saved on this computer.  
4. Select the size. Most often only done the first time, previous selections are 

saved on this computer.  
5. Select the date if it should be a different date on the images than today's date. 
6. Here is a preview of what it will look like when the images are imported into the 

series.  If there are previews that are not desired, one can easily just click on an 
image, press and hold the mouse button and pull the image out of the layout 
and drop. 

7. If there are more images on the memory card or in the folder you are importing 
from, click the text ALL IMAGES to display these in a list. You can easily click on 
an image in the list and drag and drop into the desired box in the preview 
above. 
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8. If you want to empty the preview from all images, click CLEAR. Then do 
according to step 7. 

9. Click IMPORT when you feel satisfied with your choice. 
10. CANCEL closes the dialog box without any changes or import. 

 
 
 

 
Warning  
To avoid confusion of patient information, the "Export to DICOM" option should be used as 
this means that patient information is stored in the file. If other image formats are selected, 
"Burn patient information" should be enabled, then patient information will be printed in 
plain text below the image. 
 

 
 

EXPORT TO CD 

Export to CD can export either all images in a exam or only those that are selected. To 
highlight images hold down the Ctrl key and click on the images to select, the images 
will get a green frame as a highlight. 

 
 
Whether you choose to export all images or selected, you will get the following dialog 
box. Below the picture, the different choices are described step by step. 
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1. Under Format there are the following choices to choose from. Export in DICOM 
format is preferred, but this requires that the recipient of the files has a 
software that can read DICOM files.  

 
2. Under Export options, you can choose whether to Anonymize the images, and 

you can also choose whether to burn patient information into the image or not. 
If no choice is made here then the image will be saved with patient and series 
information as file name, example of this: 19690101-1005_A. LYING 
BITEWING_2016-02-10_08-42-21.jpg 
 

3. Make sure you have inserted a blank disc into the CD/DVD burner. 
Click Burn to CD/DVD. 

4. You will then see this dialog box: 

 
5. Select the device that will burn the images and check that all the criterias are 

met:  
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6. Click Burn and wait for the disc to finish. 

 

 
Warning  
To avoid confusion of patient information, the "Export to DICOM" option should be used as 
this means that patient information is stored in the file. If other image formats are selected, 
"Burn patient information" should be enabled, then patient information will be printed in 
plain text under the image. 
 

 

CHANGE THE IMAGE DATE 

Change Image Date is used to easily change dates on existing images that, for example 
if images have been imported with the wrong date. Note that you can only change the 
image date on series/exams that are not locked. If the exams/series are locked then the 
buttons are disabled. 

 
 
Change the image date feature is disabled by default. To activate go to Onepix settings 
and click in the box of Show buttons to change image date 

 
 
To change the image date of individual images, select one or more images by pressing 
down the Ctrl key and clicking on the images so that they are marked with a green 
selection. Then click the Selected button under Change Image Date. 
 
To change to the same date for the entire series, select an image in the series and click 
the All button  under Change Image Date.  
 
Select the correct date by clicking the calendar icon and clicking Select 
 

 
Make sure that the date below the image in the exam view is updated for selected 
images. 
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PLUGIN 

 
Under PLUGIN, the installed Onepix plugin will appear. Plugins can be selected during 
the installation process. Here are some examples of the plugins available  in Onepix. 
 

   
 
TWAIN PLUGIN 
Twain plugin is used for acquiring images from a Twain-compatible source, such as an 
image plate scanner or a panoramic machine. To select the twain source go to Onepix 
settings and click on Edit Twain Source button. 

 
 
To acquire images from a Twain source: Create a new Twain Study/Series with modality 
OT (Other), select an image position and click on Twain plugin. 
 

 
 
Please note that twain sources have their own design and dialogue so the image 
acquisition process could be different for different sources. Refer to the manufacturers 
user manual for each Twain source. When you have acquired images in the twain 
dialogue and close the window/dialogue the images are sent to Onepix. To 
test/troubleshoot the Twain source you can use an open source application such as 
Twacker. 
 
PACS EXPORT 
Pacs Export plugin is used to send images from Onepix to a Pacs server.   
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The workflow is simple, you select a series that you want to export and click on 
the Pacs Export button. It will send all images in the selected series to Pacs. 

 
  
Yuu can find settings for Pacs Export in CDRPacs.ini file in folder C:\Program Files 
(x86)\Unident AB\Onepix\Plugins\Study\Legacy\PacsPlugin\ 

 
  
When Pacs Export plugin is installed, you will also see that you get new button called 
WORKLIST in Onepix. This can be used to get patients from a worklist system such as 
RIS for example. 

 
  
The settings for the worklist is in uwm.ini file in folder C:\Program Files (x86)\Unident 
AB\Onepix 
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CBCT PLUGIN 
CBCT Plugin is used to export a CBCT study to an external CBCT Viewer. Onepix can 
store CBCT studies but it can only show one image slice at the time. Select the CBCT 
Study you want to export and click on the CBCT Plugin.  
 

 
 
In Onepix settings when you click on button CBCT Plugin you can choose which Viewer 
type you use and you can also do the settings for Snapshot, Output and Viewer path. 
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FACAD PLUGIN 
Facad Plugin is used to export images to an external viewer called Facad. You select the 
image to export and click on the Facad Plugin button 

 
 
The settings for the Facad Plugin is located in C:\Program Files (x86)\Unident 
AB\Onepix\Plugins\Study\FacadPlugin\FacadPlugin.dll.config file. 

 
 
 
 
STL IMPORT PLUGIN 
STL Import Plugin is used to import STL files to Onepix. Create a new study or seies with 
STL (3D Manufacturing Model) modality and click on  STL Import Plugin. 

 
 
Click on BROWSE and select a folder containing STL files. Choose which files to import 
and click on IMPORT button. 
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3SHAPE UNITE PLUGIN 
3Shape Unite Plugin is used to import 3D models from 3Shape Unite Software to 
Onepix. Create a new study or series with STL (3D Manufacturing Model) modality and 
click on 3ShapeUnite plugin button.  
 
 
3SHAPE UNITE SETTINGS 
 
Go to Onepix settings 

 
 
Click on 3Shape Unite Plugin 
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Click on ADD button 

 
 
 

 
 
Type in the connection information that you can find in 3Shape Unite Software, se 
below. 
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Choose a user/password and click on Apply and then copy the information and paste it 
in Onepix settings. 

 
 
You can add more then one scanner. Click on OK when finished. 

 
 
 
3SHAPE UNITE INTEGRATION WORKFLOW 
 
Note that for this to work 3Shape Unident software needs to be running. 
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This opens the 3Shape Unite Plugin dialogue.  
 

 
 
If you are about to do a new scanning, go to the 3Shape Unite Software and click on 
the button in the left lower corner to create or open the patient and proceed with the 
scanning. 
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When the scanning is completed, go back to Onepix to import the 3D Model. 
Click on BROWSE. 

 
 
Select a 3Shape Unite study/content and klick OK. 
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Choose which 3D Model to import and click on IMPORT button 

 
 
DoubleClick in a position to view the 3D model in zoomview 

 
 
In zoomview you can use the tools on the left side to zoom, rotate and move the 3D 
model. 
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IMAGE ACQUISITION 
When an exam or a series is created, a blank layout appears with today's date ready for 
image acquisition. This is shown by the presence of a symbol with +START in the center 
of the frame as in the image below. 
 

 
 
At the top right of the series is a small droplist with an arrow and a name of the sensor 
manufacturer used by default. If you want to temporarily use a different kind of sensor 
then you can click on the arrow and select the other hardware, as in the image 
example below. In Onepix settings, you can set which hardware should be pre-selected 
here for all new X-ray series on this specific PC. 
 

 
 
To start an image acquisition, make sure the hardware is plugged in.  Hardware means 
all image hardware such as x-raysensor, photo camera, scanner, panorama etc.  Then 
click on the +START button in the position where the image acquisition should start and 
wait for it to say ready below the frame.  The frame is enabled and ready for image 
loading.  
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Warning  
In order for the patient not to be exposed to unnecessary X-rays, it is important that you 
wait until the position box in the onepix examination window flashes/lights up green 
(default color) in auto capture mode, or until the message "waiting to take X-ray image" 
appears before activating the X-ray source. 
 

 
 
When acquisition occurs, the last captured image is displayed in full screen for 3 
seconds, by default, but you can change this time under settings.  When the image is 
then closed, the programme returns to the image acqiosition mode and the activation 
is moved to the next position in the seriesorder. In other words, you do not need to 
activate each position, it is enough to activate the first one. The seriesorder in which 
the images are acquired is displayed in the empty frame at the bottom left. 
 
If the hardware is not connected or if you do not get any contact with the hardware for 
some reason, then you will see the following information below the frame: 

 
 
Do not take pictures if you receive this message, but make sure that the hardware is in 
and that you get a position with green marking that is ready for image capturing. If the 
hardware is connected and you still receive this message, contact technical support. 
 

 
Warning 
If the image is not loaded correctly in Onepix, hardware and software troubleshooting 
should be carried out before new exposure is performed. With some hardware, the image 
can be re-sent without new exposure directly from Onepix. 
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MULTIPLE IMAGES IN THE SAME POSITION 

You can load more than one image into the same frame. To activate the box for image 
capture, click on the plus symbol that appears in the middle of the frame. Plus symbol 
appears only if the series is created today. 

 
 
If more than one image is in a frame, it looks like the image below. Click the right or left 
arrows to choose which image to display at the front of the stack. 

 
 

 
Warning 
When a stack symbol appears below an image, multiple images in the same position are 
available. Switch between the images using the arrows that appear when the cursor is 
hovered over the image. 
 

 
 

IMAGE MANAGEMENT AFTER ACQUISITION 
When the image acquisition is complete, you have the same day to edit the exam and 
the images. After that, the exam is locked and no changes can be made unless it is 
unlocked manually. It is still possible to see and read all the information, but no 
changes are saved on exams older than one day.  To unlock an exam requires going 
through the Onepix Admin software. 
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Already in the exam view, there is now the possibility to: 

- Rotate an image at 90 degrees clockwise/counterclockwise using the arrows 
located below the image.  

- It is possible to detach/unmount an image, if it is not good enough to be 
displayed in the series, by clicking on the trash can icon.  This does not remove 
the image, it is just not  presented as mounted in the series.  The image ends up 
under a tab called DETACHED IMAGES directly below the series where you can 
easily choose to attach it back into the series if you want.  

- The symbol (i) shows if there are any comments and how many there are in the 
picture. You can read the comments if you click on the symbol.  Here you can 
also write/change a Global comment for the image. 
 

 

 

DETACHED IMAGES 

If there are any detached images in the series then a tab will appear as shown in the 
image below under the series. 

 
 
Click the arrow to open the list of the detached images. All detached images are 
displayed in a horizontal list. 
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To reattach the image, you can click on the image in the list under detached images, 
pressing down the mouse button while moving the image to an empty position in the 
series. Please note that this is only possible during the same day while the series is 
unlocked. Detaching and attaching in older exams can be done through the Onepix 
Admin tool or by unlocking the exam via Onepix Admin. 
 

STUDY NOTES 

Under each exam , there is a notes field where you can write/read notes for this exam. 
Click the arrow to the left of the notes text and then click the line below to read/write 
notes. Press Enter to type on new line.  

 
 
Study notes provide the ability to add general notes to a study (also known as "exam").  
Users who use study notes usually add and modify them at the end of the exam, as an 
easy way to add general observations.  Study notes can only be added during the same 
day as the exam is created,  this can be edited afterwards via Onepix Admin if 
necessary. 
 
 

KEYBOARD SHORTCUTS IN EXAM VIEW 
Listed below are the keyboard shortcuts available in Exam View. 

 
COMMAND NAME KEYBOARD SHORTCUT 
New exam Ctrl + N 
Search patient Ctrl + O 
Close Ctrl + W 
Copy image Ctrl + C 
Select all Ctrl + A 
Print 
Browse list function when overlapping 

Ctrl + P 
Up/Down arrow 

Esc Close compare window or dialog 
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ZOOM VIEW 
 
This section includes: 

- Tools to View/Manage/Adjust Images 

- STL Viewer 

 

 
When you doubleclick an image in the exam view, that image opens in the so-called 
zoom view. Please see the STL Viewer section below for how to work with STL files. To 
the left of the image are image tools and to the right are information and image 
enhancement sliders.  Any changes made in the Zoomview is automatically saved if the 
image is taken on the same day that changes are made. You can still make changes and 
adjustments to images older than a day, for review, etc., but those changes will not be 
saved to the image. To go back to the exam view, use the BACK button at the top left.  
This section describes the different parts of the Zoom view with its capabilities. 

 

TOOLS 
On the left side of the image in the zoom view are imaging tools. Below is a description 
of these and how they are intended to be used. 
 
 
BRIGHTNESS AND CONTRAST 

 
Brightness and contrast are among the most common tools used in The Zoom View and 
are therefore active by default when opening an image in The Zoom View.  

1. Click on the button to enable the tool if it is disabled.  
2. Then click in the image and keep the mouse button pressed. 
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3. Move the mouse pointer Up/Down for brightness . 
4. Move the mouse pointer Left/Right for contrast. 
5. To return to the original image, double-click in the image. 

Changes in brightness and contrast also occur on the controls located under Filters on 
the right side. All changes are saved under History. 
 
 
ZOOM 

 
Enlarge the tool is used to zoom in/out an image as follows: 

1. Click on the button to activate the tool. 
2. To enlarge an area quickly, you can double-click in the image. 
3. It is also possible to use mouse wheels to zoom in or out. 
4. Click in the image and hold the left mouse button. 
5. Hover the Up or Down cursor to zoom in or out. 
6. To return to the original image, double-click in the image. 

Zoom feature remains enabled until you select another tool or close the Zoom view. 
 
 
MOVE 

 
 
Provides navigation capabilities in an image. The Move tool is used in conjunction with 
Zoom and makes it possible to exam adjacent areas of an zoomed image. 
To pan the image, follow these steps: 

1. Click the Move button. 

2. Use mouse wheels to zoom in the image, or double-click on the part you are 
interested in. 

3. Keep the mouse button pressed and move the cursor either up/down or 
right/left. 

4. To return to the original state, you can just double-click in the image regardless 
of the state in which you are in. 

The move function remains active until you select another tool. 
 
 
FLASHLIGHT 
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Enhances or "lights up" a certain area of an image. 
 
Clicking the Flashlight button activates the maximum contrast feature as the default 
setting. Hover over the image with mouse to see results. If you right-click on the image, 
a menu will appear where you can select other sizes and filter functions. 

 
  
The following settings are available for Flashlight: 

- Choices from Small to Extra Large Beam 
- Maximize contrast – Illuminates the image 
- Positive - Inverts the image 
- Magnifier – Magnifies the image 
- Relief - Applies a relief effect, giving it a three-dimensional appearance. 
- Colorize - Color the image 
- Freeze – Makes the flashllight stay in the same place, click freeze again to drop. 
- Off - Turning off the Flashlight tool 

Flashlight remains active until you select another tool or right-click and select Off. 
 
 
AI – SECOND OPINION 

 
Provides you with support by alerting you to the conditions that may appear in your 
patient's pictures so that you can make the correct diagnosis faster. 
 
The first time you click on the AI button you will be given the option to register your 
account. Fill in the details in the form, read through and agree to the terms and 
conditions and you can start using AI immediately by clicking on the Activate AI button.  
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When you click on the AI button the information is loaded into the image. The result is 
displayed in the image. 

 
 
 
When you hover over a highlighted area with the mouse arrow, you get a little more 
information. 
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Caries is shown with a mark around the area where caries is assumed to be present. 

 
 
When the AI button is activated, you will also get the Second Opinion in the panel on 
the right side of the image. Here you can choose to what degree the tool should react. 
By default, the tool is based on medium, but the slider can be moved to low or high 
confidence. Below the slider you can also choose what information you want to be 
displayed in the image such as caries, fillings , etc. These settings are saved per 
computer in the settings file OnepixSettings.xml 

 
 
In Onepix settings, you can choose whether you want AI to be activated automatically 
every time you open an image in review mode and whether you want non-pathology to 
be displayed or not. 
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Once you have registered an account, Onepix will download the second opinion 
information directly after image acquisition. This function can be turned off in Onepix 
settings by checking Disable Pearl AI Processing setting. 

 
 
 
RULER 

 
 
When you click on the ruler tool, you get three choices: RULER, MEASURE ANGLE, 
RECALIBRATE and PIXEL VALUE. Below is what can be done with the different tools. 
 

 
Warning  
The measurement result is highly dependent on the use of calibration objects and sensor 
placement. Measurement errors due to distortion as well as the limitation that a two-
dimensional image implies can lead to misdiagnosis or malpractice. The user of the 
measurement function should have good knowledge of projection technology in order to 
obtain a satisfactory result. 
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Warning  
Diagnosis or treatment must not be based solely on measurement results due to the risk of 
measurement errors. 
 

 
 
 
RULER 
Distances can be measured between two points. The result of the measurement is 
displayed on the measuring line and in the status bar. 

 
 
To measure distances with a straight line, do as follows: 

1. To specify a starting point, press and hold the left mouse button.  
2. Press and hold the button until you have entered the distance you want to 

measure.  
3. When you release the button, the length of the line between the two points is 

displayed in the picture.  
4. When you start a new measurement, the first line disappears. 

The measurement result is displayed in millimeters if the image is calibrated otherwise 
it says Px for the number of pixels.  This feature you can use to quickly assess straight 
distances.  You can print an image with measurement results by using Ctrl+P or clicking 
the print button. 
 
 
MEASURE ANGLE 
Measures the distance between several lines and the angle between two straight lines. 
Multiple Lines and Angles are two different features, but are presented together in this 
section. 

1. Specify a starting point in the image by clicking the left mouse button once and 
release.  

2. Drag the mouse cursor and draw the next line by moving the cursor and left-
clicking again at the end of the line.  

3. Continue on the line or end the measurement by right-clicking.  
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RECALIBRATE  
Sets distance information for an image. The calibration function allows you to correct 
distortion problems caused by incorrect sensor position, misdirected beam or other 
factors. You can correct the problem by placing a straight object of known length (such 
as a file) in the area being X-rayed. The object serves as a reference point for 
measurement once you have taken the picture. Take an X-ray.  (In this example, the file 
is the object of known length.) 
 

1. Click the left mouse button to specify a starting point parallel to the file and 
hold down the button until you reach the other end of the file.  

2. When you release the button, the Distance Calibration dialog box appears. 

 
3. Enter the actual length of the file, dimensions in millimeters, in the text box and 

click OK. 
4. The calibration is complete, when you measure in the image you will see that 

this is a calibrated measure by saying (cal) after the measurement. 
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When you save the image, the new calibrated value is saved, so that the image does 
not need to be recalibrated. When you reopen the image, the saved value is applied as 
a starting point for all measures. The word (cal) is visible after the metric. 

 

PIXEL VALUE  

Displays grayscale pixel values in the image. Select Pixel Value, then move mouse 
cursor to an area of the image. The pixel value in the current area appears next to the 
mouse pointer.  

 
 
Pixel values are a measure of density, so if the density in the X-rayed range is relatively 
high (e.g., bone), then the pixel values on the grayscale within the range are low to 
medium. When the X-rays pass through low-density areas (such as air), the pixel values 
become much higher. 
 
Knowing pixel values can help in assessing whether the exposure is dark enough to 
evaluate. The darkest pixels should be between 92 and 99%. If they fall below the limit 
value, you can re-shoot the image with slightly higher exposure to get better image 
quality and make it easier to distinguish between contrasting areas. 
 
 
DENSITY PROFILE 

 
Displays the grayscale value for each pixel along a vertical, horizontal, or user-defined 
line. Density profiles are used to find areas of pixels that have similar grayscale 
percentages. It can be used to determine the spread in areas with pathology and to 
find other areas of the picture with similar characteristics. Like the other measurement 
tools in Onepix, you can print the image with the current density profile using the 
keyboard shortcut Ctrl+P or click the print button in the zoom menu. 
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LINE PROFILE 
For line profiles, click once in the image to highlight the starting point of the line, hold 
down the button, and drag the line as far as you want it. When you release the button, 
the profile will appear. 

 
 
 
 
VERTICAL PROFILE 
For vertical profile, click on any pixel in the image and a density profile will be created 
in the image that measures all pixels in the line. 

 
 
 
 
HORIZONTAL PROFILE 
For horizontal profile, click on any pixel in the image and a density profile will be 
created in the image that measures all pixels in the line. 
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NOTE 

 
 
Adds comments with flags to an image. Comments can be added at any time in an 
image opened in the zoom view. The cursor changes to an arrow. If you click in the 
image, the dialog box appears as shown in the image below. 

   
 
In the Insert New Note dialog box, you can type in the comment text. Here you will get 
suggestions for most common comments as soon as you start writing. Use the down 
arrow and press Enter or click on any of the suggestions if you want to use it. 
Otherwise, you can just keep typing in the text you want to type instead. 

 
When you're done with the note, click OK.  Then the dialog box closes, the note is 
assigned a number, and the text is saved. The comment in the image is visualized as a 
small arrow and comment icon. The comment text appears when you move the mouse 
arrow over it. 

 
 
To remove or edit a comment: 

1. Make sure you have clicked and activated the comment tool.  
2. Then click on the comment in the image. You will then get this dialog box. 



 
 
 
 
 

59 
 

 
3. Change text and click OK to edit. 
4. Click DELETE to delete the comment. 

Remember that you can only create, modify, or delete comments on images taken on 
the same day. Images older than one day are locked for editing and can only be 
unlocked via the Onepix Admin software. 
 
 
 
SHOW/HIDE 
This feature allows you to show/hide comments in the image. The comments are 
hidden only while you remain in the zoom view. If you choose to close the image and 
reopen it in the zoom view, then the comments will appear again. 
 
 
DRAW 

 
 
Drawing tool is a tool for adding freehand notes to, for example, X-ray images.  

 
 
When the drawing tool is selected then you can right-click in the image to get the 
selections available for the tool.  

 

1. The Erase option removes everything that is drawn in the image.  
2. The Size selection allows you to select the width of the drawing tool, by default 

it is Medium. 
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3. The Color option means that you can change what color the drawing tool will 
use. You can draw with all colors in the Windows palette, the color is applied to 
all drawings in the picture.  

 
 
ROTATE 

  
These tools allow you to change the image orientation. In some cases, the function can 
be used for images that are acquired in the wrong position. Normally, images are 
automatically rotated in Onepix to their correct orientation based on the position, 
which is usually sufficient. In other cases, additional reorientation may be needed. All 
changes appear as saved under HISTORY to the right of the image. 
 
There are four ways toc hange the orientation of an image:  

- ROTATE RIGHT 
Rotates the image 90 degrees clockwise. 
 

- ROTATE LEFT 
Rotates the image 90 degrees counterclockwise. 

 
- MIRROR UP/DOWN 

Turns the image so that it is mirrored vertically. 
 

- MIRROR LEFT/RIGHT 
Turns the image so that it is mirrored horizontally. 

 
 

 
Warning  
If the "Mirror Up/Down" and "Mirror Left/Right" settings are used, the image will appear 
mirrored. If the image is acquired up and down to the series, the setting "Rotate Right" or 
"Rotate Left" should be used.  
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CROP 

 
The Crop feature is used to gradually rotate and crop photos. The changes are saved 
under history such as Rotate/Crop and you can always return to the original image by 
clicking Delete under the history. 

 
 
To begin cropping the image, click the Rotate/Crop button or press the Ctrl + C keys.  
 
The current image will then be displayed with horizontal and vertical lines.  

 
 
To crop the image, click and drag any of the corners. 
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For rotating, click in the image and hold down the left mouse button while dragging to 
the left or right with the mouse cursor to gradually rotate the image as desired, release 
the mouse button when the desired rotate is achieved.  
 

 
 
When you feel that the image is ready to be saved, click the Crop button. If you are not 
satisfied, click Cancel and redo the procedure.  

 
 
 
 
HORIZONTAL AND VERTICAL LINES 
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To show or hide Horizontal and/or Vertical Lines in the image, click any of the buttons 
or use key combination Ctrl+G or Ctrl+Q 
 

 
 

 
 
 
FULL SCREEN 
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If you want to hide all information in Zoom view except the image, click the Full Screen 
button. Full-screen mode maximizes the image by enlarging it to fit the entire screen. 
To return to the zoom view, click the Close button in the upper left or press the Esc 
key. 
 
PRINT 

 
Prints the current image in Zoom view. The printed image contains the improvements 
and options applied (contrast, color scheme, etc.). The changes appear in the image in 
the printed report even if the changes themselves haven't been saved yet. You can also 
choose to include information about the patient, dentist, examination and image in the 
printout. 
 
INFO 

 
 

INFO OVERLAY 
Click here to show or hide text in the image that shows tangible image information. 
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IMAGE INFO 
With this feature, you can show all the DICOM tags that exist for the image. Here you 
can copy all the tags to the Windows clipboard. Furthermore, you can save or send this 
information by using Ctrl+V to paste information into a text file or similar.  
 

 

 

SIDE PANEL 
On the right side of the image there is a panel where you can make adjustments, filters, 
see the information and status of the image. In this section, below we go through the 
idea behind these. 
 
 

EXPOSURE QUALITY 

Exposure quality exists to provide an assessment of the images in avial way, by marking 
an area where the image exposure is judged to be optimal.  The exposure quality meter 
is available for X-ray images with 12-bit bit depth or higher.  To turn off exposure 
quality so that information is always hidden, go to Onepix's settings and in the Zoom 
view section, clear the exposure quality check box. 
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- The green area in the middle of the meter means that the image was optimally 
exposed based on the technology factors used. 

- The light gray area on the left means that the image was underexposed and 
that a change in the technology factors would improve image quality. 

- The dark area on the right means the opposite, that the image was overexposed 
and that a change in the technology factors would reduce the patient dose 
without degrading the image quality. 

 

FILTER 

If the images are taken with a sensor that supports filters, these will be available in a 
drop-down menu, as in the image example below where General Dentistry is the 
default filter for Schick 33 / Fona sensors from Sirona. How to choose which filter to 
display by default can be read about in usermanual for each sensor. 
 

 
 

 
Warning  
Incorrect settings in AutoFilter can lead to an image that is not diagnosable. Return to the 
original image if you suspect that a filter has distorted the image. 
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SHARPNESS 
Sharpening is an image enhancement filter that has been developed specifically for 
Schick 33 and Fona system images. With sharpness, different image optimization 
functions are combined that increase contrast and make the details appear better. 
Sharpness is automatically applied to all images taken by the Schick 33 or Fona sensor. 
The level of focus to be displayed by default can be read about in the user manual for 
each sensor. Note that when you adjust the image sharpness using the sharpness 
slider, the changes to the image will not be saved. 

 
Before sharpening 

 

 
After sharpness of 35% 

 

BRIGHTNESS/CONTRAST 
You can either use the Brightness/Contrast tool to the left of the image or you can use 
controls on the right side that are separate for Brightness/Contrast to fine-tune. 
Regardless of the tool used, information is presented in this field. 
 
 
 
SHARPNESS FILTERS 
By default, the sharpening function is displayed using only one slider, called the 
"Sharpen filter".  When this slider changes from its default value of 0, the sharpness of 
the image changes.  

 
What sharpness does is change the contour contrast. This means that the higher the 
value of Sharpness, the darker and lighter the sides of the contour will be.  To display 
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advanced sharpness controls, there is a checkbox in "Onepix Settings" called "Unsharp 
mask advanced controls".  When enabled, three controls called Sharpness, Radius and 
Threshold  are displayed. 

- Radius determines how large an area around the contours will be affected. An 
increase in value causes the darkening and brightening to spread further away 
from the contour. 

- Sharpness controls how much the contour contrast should be increased. This 
means that the higher the quantity value, the darker and lighter the sides of the 
contour will be, respectively. 

- The threshold determines how large the tonal difference must be for the 
program to consider something as an outline. The higher the value, the more 
distinctive the contours must be to be sharpened. 

- All adjustments are saved under History with the name Unsharp mask. 

See examples below of what an image might look like after adjusting these sliders. 

 
Before sharpening filters 

 

 
After sharpening filters 

 
 
REVEALER 
Displays X-ray images with greater detail than with light/contrast and preserves clarity 
with very little interference and artifacts. Unlike other image contrast tools that do not 
preserve intermediate values in an image, Revealer uses the entire volume of the X-ray 
image and enlarges each individual pixel. By processing each pixel separately, Revealer 
creates access to more visual information and displays it in a way that makes subtle 
differences in the image appear more clearly. The change is applied when you check 
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the Revealer box.  Uncheck the Revealer box after you finish reviewing if you don't 
want it saved to the image. 

 
Before revealer 
 

 
After revealer 
 
 
COLOR 
Applies a layer of color by mapping pixel values from an 8-bit grayscale to a 24-bit 
color. Coloring is another tool in identifying possible problemareas during an 
examination, as some differences are easier to distinguish in color. Check the Color 
box.  Adjust the color using the contrast and brightness controls.  Uncheck the Color 
box after you finish reviewing if you do not want it to be saved on the image. 
 
 

 
Before coloring 
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After coloring 
 
 
POSITIVE 
Inverts the grayscale of the image, so that negative images appear as positive and 
positive as negative. Check the Positive box to apply the function.  Uncheck the Positive 
box after you finish reviewing if you do not want it saved on the image. 

 
Negative 
 

 
Positive 
 

HISTORY 

History keeps track of all changes to an image and can be used to remove them by 
clicking Delete. The changes are displayed one at a time and any enhancement applied 
to an image can be removed, provided that this occurs during the same day that the 
image was taken or loaded. Images older than a day are locked for change and can only 
be unlocked via Onepix Admin if needed. 
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POSITION 

Position shows which teeth the current image represents. If the picture is acquired in 
the correct position in the series, the teeth information will be filled in automatically. It 
is possible to click on the tooth to add or remove the teeth that are not shown in the 
image. Changes are saved to the image only if they are made on the same day as the 
picture is taken. Any images older than a day are locked, and changes to the zoom view 
are not saved. 

 

 
Warning  
Marked teeth in the dental status are based on information added when acquiring the 
image. This may deviate from reality if the image was acquired in the wrong position in the 
series or if the necessary manual correction of the dental status was not made after 
exposure. 
 

 

NAVIGATION 

In navigation, the exam series is displayed in miniature. The idea of this is that you 
should be able to easily see which image in the series you have in the zoom view and 
that you can easily select another image in the series without having to go back to the 
exam view.  You can also navigate by using the arrow keys on the keyboard. 
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STL VIEWER 
When you doubleclick on a thumbnail in an STL Study the STL file opens zoomview in 
STL mode where you can view the 3D Model. Tools on the left can be used to Move, 
Rotate and Zoom in and out in the 3d Model 
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KEYBOARD SHORTCUTS IN ZOOM VIEW 
 
Command name Keyboard shortcut 
Esc Back to exam view 
Brightness/Contrast tool Ctrl + B 
Zoom tool Ctrl + Z 
Move tool Ctrl + M 
Flashlight Ctrl + L 
Ruler tool Ctrl + R 
Measure Angle Tool Ctrl + A 
Recalibrate tools 
Pixel value 

Ctrl + W 
Ctrl + X 

Line profile tool Ctrl + J 
Vertical Profile Tool Ctrl + V 
Horizontal Profile Tool  Ctrl + H 
Note tool Ctrl + N 
Show/Hide Notes Ctrl + E 
Draw tools Ctrl + D 
Rotate right Ctrl + > (Right key) 
Rotate left Ctrl + < (Left key) 
Mirror Up/Down Ctrl + K 
Mirror Left/Right Ctrl + O 
Crop Ctrl + C 
Horizontal lines Ctrl + G 
Vertical lines Ctrl + Q 
Full screen Ctrl + F 
Print Ctrl + P 
Info Overlay Ctrl + Y 
Image Info 
Browse in Navigation 

Ctrl + I 
Arrow keys 

 
 
 
 
 
 
 
 

  



 
 
 

 
 

74 
 

ONEPIX SETTINGS 
 
In this section you will get information about what settings you can do in the Onepix 
client. To get to settings, click on the symbol that looks like gears at the top right of the 
program. 
 

 
 
 

DEACTIVATE LICENSE ONEPIX LOCAL 
At the top in settings is license and activation information.  

 
 
If you want to change computers, you can, for example, deactivate your license on the 
old computer and activate with the same license key on the new computer after 
installing Onepix. There are two different ways to deactivating a license, depending on 
whether the computer is connected to the internet or not. 
 
ONLINE DEACTIVATION 
If your computer is connected to the internet, i.e. is online, and you click on the 
Deactivate License button then you will get the dialog box as shown below. Click on the 
button to deactivate the license on this computer. 

 
 
 
OFFLINE DEACTIVATION 
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If, on the other hand, your computer is not connected to the internet, i.e. is offline, 
then you will get the following dialog box instead. To proceed with the deactivation 
click on the text Offline Deactivation. 

 
 
If you are absolutely sure that it should be done, click Deactivate License in the 
following box, otherwise click Cancel. 

 
 
Copy the key in the following box and go to onepix.se/activate, on a computer that has 
internet, and follow the instructions on the page. Do not click on Cancel in the dialog 
box below until you have completed the instructions. 

 
 
NOTE It is important that you follow through with the instructions for disabling the 
license. You will not be able to activate the license on another computer if the 
instructions are  not fully followed.  If you have any questions, please contact technical 
support. 
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ONEPIX CLIENT SETTINGS 
 
LANGUAGE 
Here you can choose 

- Which language Onepix client should be shown in. 

 
 
CHECK UPDATES 
In Onepix there is the possibility to download updates automatically. Onepix notifies 
the user when update is available. Here you can set: 

- If Onepix should check for updates automatically.  
- You can also choose if you want updates a little earlier than normal, i.e. as soon 

as the launch is made, by selecting Select from this list. 

 

 
 
EXAM WINDOW 
Here you can choose, among other things: 

- If exams are to be locked at the end of the day. 
- What size the images should be in the exam view (Size is in pixels). 
- Quick zoom window size can be set here too (Size is in pixels). 
- Choice whether thumbnails should be used in the exam view or not and the 

quality of these. 

 
 
VIEWSET TEMPLATES 
Here are settings for layouts such as: 

- Size of layouts, width oh height (Size is in pixels). 
- Path to layout files 
- Quality of thumbnail etc. 

 
 
ZOOM WINDOW 
In the zoom view, there is some information on the right side of the image. Here you 
can choose what to show or hide. If it should be displayed it should be check and if it 
should not be displayed then checked out. Some choices available here are: 
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- View exposure meter 
- View navigation 
- View history and others... 

 
 
ACQUISITION 
Here you will find settings for autotake, autofilter etc.  

- Autotake is the function that is activated when acquiring new images in a series. 
Here you can set the color of the autotake for start and stop, and how long the 
acquired image should be displayed on the screen before it goes back to the 
series/exam to take a new picture. 

- Autofilter provides the ability to apply image adjustments automatically to 
images acquired with any of Onepix acquisition modules. The image 
adjustments that can be made are Histogram Adjustment, Median Filter and 
Unsharp Mask. The changes added to the images are saved under HISTORY in 
Zoom view. 
 
To load a sample image that previews set filters, select an image in the exam 
view, then go to Onepix Settings and click the Edit AutoFilter button. 
 

 
Click Add to create a filter. Give the filter a name, TestFilter in the example, and 
then tap OK.  
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1. Select the filter to use or adjust. 
2. The histogram can be adjusted automatically by using the Auto Level 

function. Click in the checkbox, and then click the arrow next to Histogram. 
Then check the checkbox at Auto level. In order for the automatic to work, it 
is sometimes required to set Low threshold or High threshold. One such 
example is if a sensor has cut corners.  Then the Low Threshold may be set 
to, for example, 0.001 to exclude these black corners from the calculation. 
To manually adjust the Histogram, click the arrow next to Histogram and 
check its checkbox to activate the filter. Adjust the area by dragging the 
arrows that are on the left and right below the histogram.  To adjust 
Gamma, use the arrow in the center. 

3. To add a Median filter, click the arrow next to Median Filter and check its 
checkbox. Select Radius by dragging the slider to the desired setting.  

4. To add the Unsharp mask filter, click on the arrow next to Unsharp mask 
and check its checkbox. Select Radius, Sharpness, and Threshold by dragging 
the slider to the desired setting. 

5. The filter that is now created can be linked to the selected loading module 
in the Use for selection. 

The AutoFilter feature can be turned on and off under Onepix Settings>Acquisition. To 
apply AutoFilter to an already loaded image that lacks these filters, click the "Apply to 
Current Image" button in the AutoFilter window. 
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Warning  
Incorrect settings in AutoFilter can lead to an image that is not diagnosable. Return to the 
original image if you suspect that a filter has distorted the image. 
 

 
 
SEARCH FILTERS 
Here you can set under which path filter settings should be saved. This path applies to 
both AutoFilter and Search filter settings found in the exam view. 
 
 

HARDWARE SETTINGS 
Information about installed hardware, such as, for example, intraoral sensor, camera, 
panorama. Check the settings by clicking on the green button for each acquisition 
module.  For example, if you use intraoral sensor from 2 different manufacturers, this 
can be seen here, you can then choose which sensor to use as default by clicking on the 
star as in the image example below. 
 
 

 
 
What settings you should use be made can be read about in the user manual that 
belongs to each hardware. 
 
 
 
 
 
 
 

ONEPIX CLOUD ADMIN 
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INTRODUCTION 
 
This section includes: 

 Access to Onepix Admin 
 Manage patients and examinations 
 Manage users, permissions, and roles 
 Import DICOM exams and images 

 
Onepix Admin is accessed via the internet browser via the address 
clinic.onepixcloud.com, where clinic is the name assigned to your workplace. On the 
first page, you can select the language by clicking on the globe button at the top right. 
You can change the language at any time on the page. 

 
 
To see information about Onepix Admin, click on the button with the question mark. 

 
 
 
 
LOG ON 
Login to Onepix Admin is done through one of the login options and enter your login 
details.  Login details are provided by your clinic administrator. 
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LOG OUT 
Click on your user icon in the upper right corner. Log out by clicking on the button at 
the bottom. Here you can also see your user information. 

 
 
 

MANAGE PATIENTS AND EXAMINATIONS 
 
When you log in, you'll see a view based on your users rights. Read more about this 
under section Manage users, permissions and roles. 
 
As a clinic user, you will only see the patient list. Here you can search by patient or 
examination and review images. 
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1. Search patient via search bar, the search will begin automatically after entering 
3 letters. 

2. Choose to search for Patients or Studies 
3. If you choose to search on studies, then you search by selecting dates from and 

to. The last week's exams appear automatically. 
4. Once you have searched for the patient or the study, click on the arrow to see 

more information. 
 
This is what it looks like when you are in the patient view. 

 
1. Patient information is displayed here 
2. Click on the arrow to see the content of the series and images 
3. Click the dots to change or delete the exam/study. 
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UPDATE PATIENT INFORMATION 
In order to update patient information, you must log in as a clinic administrator.  
 

 
To update patient information: 

1. Find a patient via the search box. 
2. Click on the dots 
3. Select Edit 
4. Update the patient information and click Submit.  

 
5. Check in the patient list that the information has been updated. 

 
 
SYSTEM ADMINISTRATOR 
As a System Administrator, in addition to everything that a regular user and clinic 
administrator can do, you can also see all Companies/Clinics and manage the System 
Administrator list. Click on a company to enter and view or manage the data. 



 
 
 

 
 

84 
 

 
 
To manage the system administrator list click on the gear icon.  
 

 
 
 

MANAGE USERS, PERMISSIONS, AND ROLES 
 
 
CLINIC ADMINISTRATOR 
As a clinic administrator, you can update and manage patient information and users in 
the clinic. You can also view and update your clinic information. 
 

 
1. If there are many users in the clinic, then you can use the search bar to search 

for a user. 
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2. Click the button to add a new user. Here you fill in information such as name, 
social security number, e-mail, what role the user has and so on. Click the Send 
button to save the new user.  

 
3. Click here if you need to update clinic/company information.  

 
4. Click here to: Update User Information, Reset Password, Deactivate Account, 

Delete Account and Set a New Password.  
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5. To see user information, click on the arrow. 

 
 
ROLES AND CLAIMS 
As a clinic administrator and system administrator, you have access to the roles and 
claims feature.  
 

 
 
When you click on the Roles and claims button, you will be guided to a new page where 
you can create roles, and set rights for the roles. By default, there is a user role doctor 
and a clinic administrator customeradmin. 
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1. When you sign in as a clinic administrator, you only see the User role and can 
make settings for that role. 

2. You can create new roles where you assign different rights. 
3. Rights that you can assign concern, among other things, users/rights in clinics, 

but also which permissions/functions you want to block in the Onepix client 
application.  

 
 

IMPORT DICOM EXAMS AND IMAGES 
 
DICOM IMPORT 
To import Dicom images from a DICOMDIR catalog: 
 

1. Click the Import button 

 
2. Then click the Import DICOM as a folder button 

 
3. Select a folder on your computer that contains a DICOMDIR file and click Open 

and Upload. The files are uploaded.  

 
4. Once the images are uploaded, then you can see patient information and 

choose whether to view the images, delete or save this examination via the 
buttons on the right side

 
5. Click save to save the images of the patients. 
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ONEPIX LOCAL ADMIN 
 
This section includes: 
 

- Import DICOM studies and images 

- Export patients, DICOM studies and images 

 Separate, delete, and clear images 

- Attach and reclaim photos 

- Database search, editing, and validation 

 
When you start the data management tool Onepix Admin, either via the desktop 
shortcut or via Onepix in the Start menu, the tool's three-part screen initially appears 
without content.  To view all patient, exam, and image information contained in the 
Onepix imagedatabase, click Tools> Search, and then click OK. The standard search is 
done per patient, but if you are primarily searching for images or studies, you can 
select any of those options in the menu.  If a specific patient is sought, you can also 
click on the search button "binoculars" 
 

 

1. Area of patient/exam/image 
2. Search results and list of patient/exam  
3. Series Overview Area 
4. Image Overview area  
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FILE MENU 

 
 

DICOM IMPORT 

Imports DICOM studies and images into the current database from another device. The 
import source can be a valid DICOM file or archive, located at an available path or on a 
physical drive. Onepix loads all records into a "DICOMDIR" file set in the current 
database.  
  

 
 
Each entry contains patient/exam/series/image information and the tables in the 
connected database are populated in the same way. 
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DICOM EXPORT 

Exports patient information, DICOM studies, and images to another device. You have 
the option to create a new storage store for the items in their destination location, or 
use a folder in a location that already exists. You can select single objects, groups of 
objects (by selecting while holding down the <SHIFT> key), or all studies and images for 
a specific patient (by selecting Edit> Select All or with the keyboard shortcut 
<CTRL><A>. 

 
 

CD-ROM SETTINGS 

To load Onepix exams from a CD-ROM, browse the image folder on the disc and click 
the Install button.  Keep in mind that you can only load exams that have already been 
converted to DICOM with this action. 
When Onepix exams are recorded in the current database, it is updated with the 
volume information, so that the Onepix system knows where the exams are located.  

 
 

DICOM COMPRESSION 

Reduces the storage space for X-rays, with or without loss when compressed. 
Compressing X-ray images has many advantages, including: increased efficiency of 
storage space for images and better ability to store on removable media. 
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Following compression formats are supported:  

- Low compression rate (High quality) with JPEG2000, which saves files with a 2:1 
file size reduction. 

- Medium compression rate (Medium quality) with JPEG2000, which saves 
images with a 5:1 file size reduction. The compression rate is equivalent to Lead 
PQ1 in previous Onepix versions. 

- High compression rate (Low quality) with JPEG, which saves images with a 20:1 
file size reduction.  

 

PRINT ALL PATIENTS 

Prints a patient list.  
 
Before you print a patient list, you need to conduct a search. To open the search box, 
click Tools> Search.  Because the patient list is based on the search results, you may 
want to filter the results using the options in the search box. When you're done, click 
OK. 
When the patient list appears, click File> Print All Patients 
 

SEND TO REMOTE SERVER  

Displays a dialog box where you can save patient data to a remote location. This 
feature is especially useful for practices with multiple clinics, where backup of patient 
records takes place to a central server or where medical records are shared between 
several different locations.  
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In multi-clinic practices, more than one server can be used for journals, a local server to 
which the work computers connect, and a remote server for archiving and storage. You 
can choose to send all the studies for a particular patient, or just the studies and 
images you desire. 
 
To submit all studies for a specific patient, follow these steps:  

1. Open the All Patients folder in the Onepix Admin. 
2. Select the patient (patients) whose files you want to send. 
3. Click File> Send to Remote Server. Select a registered remote server from the 

drop-down menu in the dialog box, or fill in the text boxes if you want to add a 
new server. 

4. Click Verify to confirm the connection to the remote server. 
5. When the remote server is ready, click Send. 

 
Here's how to send the images for a specific exam:  

1. Open the All Patients folder, double-click the patient's name in the upper-right 
bar, and then double-click the exam that contains the images you want to send. 

2. Click File> Send to Remote Server.  Select a registered remote server from the 
drop-down menu in the dialog box, or fill in the text boxes if you want to add a 
new server. 

3. Click Verify to confirm the connection to the remote server. 
4. If the remote server is ready, click Send  
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EDIT MENU 
 

 
 

DETACH IMAGE 

Detaches (dismounts) images from the series. If you choose to detach an image, it is 
preserved as part of the patient exam but it does not appear in the series. Detach 
provides greater flexibility in the management of series and allows you to retain active 
and inactive series and attached/detached images.  
 
Images that you do not want to view, but want to keep, can be detached from their 
current series. An image that has been detached can be deleted or attached to its 
original, or a new, series. In the example below the image number 2 is detachedfrom 
the series. This can also be seen by the image object having a black X across the image 
icon. 

 
 
By detaching and attaching images, you can adjust the exams to show relevant images 
in an appropriate series. It is common for relevant images to be scattered over several 
exams, which sometimes complicates comparisons. With Onepix Admin, you can verify 
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that the most relevant series is active, and then drag and drop images (from the upper 
right bar) to the view set (in the lower right bar).  
 

DELETE 

Removes patient, exam or images from a particular device and moves them to the 
trashbin. Removal of patient studies and images in Onepix is done in several steps in  
Onepix Admin, to ensure that your data is not accidentally deleted.  
 
When a patient is deleted, all studies/exams, series, and images for the patient are 
deleted (they are moved to the trashbin in Onepix Admin).  
 
When an exam is deleted, all series and images from that exam are deleted (moved to 
the trashbin in Onepix Admin).  
 
If a series object is deleted, all images are detached. The images can be atatched in a 
different series or deleted (moved to the trashbin in Onepix Admin). When an image is 
deleted, it is detached and can either be attached to another series, or deleted (moved 
to the trashbin in Onepix Admin). 
 

 
 
The steps for deleting patient, studies and images are similar and are described below:  

Start the Onepix Admin software. Perform the following steps in the patient list:  

1. Select a patient folder (in the left bar) so that the list of studies is displayed (in 
the upper right field), or select an exam folder (in the left bar) so that the list of 
series and images is displayed (in the upper right field). 

2. Select the patient, exam, series, or image that you want to delete. (Patients can 
only be deleted in the upper-right bar, when the All Patients folder is open.) If 
you choose to delete a patient, all studies, series, and images associated with 
the patient will also be removed. The same goes for studies, where view sets 
and images linked to the exam are removed. 

3. Click Edit > Delete.  This will move all current items to the trashbin in Onepix 
(under the patient list folder in the left bar). 

4. If you want to delete the items totally, clear the  Recycle Bin in Onepix Admin 
(You are advised not to clear the Recycle Bin unless you are absolutely sure that 
the correct items are being cleared). 
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UNDELETE 

Withdrawing deleted studies and images. With the Onepix Admin tool, it is possible to 
recover deleted studies and images. Items deleted using the data management tool are 
first moved to the trashbin in Onepix Admin. (The Onepix trashbin is in the left bar, 
after the list of patient folders.)  
 
To recover studies and images from the Onepix Recycle Bin, open the Recycle Bin and 
select the items you want to recover, or click Edit> Select All to recover all. Then click 
Undelete in the Edit menu. 
 
If a patient is undeleted, all studies, series and images for the patient are also 
undeleted(restored from the trash in Onepix). If an exam is undeleted, all series and 
images in the exam are also undeleted (restored from the trash in Onepix Admin). If an 
active series is undeleted(restored from the Onepix Recycle Bin), all images are 
attached to the series. If an image is reverted (restored from the Trashbin in Onepix 
Admin), it attaches to the currently active view set. 
 
If the items have been emptied from the Onepix Recycle Bin, they can still be recovered 
from the Recycle Bin in Windows, provided that the operation was performed on the 
computer where the images are locally stored. Recovering items from here requires a 
few more steps. A step-by-step description of how to recover emptied items can be 
found under the heading "Purge". 
 

PURGE 

Moving deleted patients, studies/images from the trashbin in Onepix Admin to the 
recycle bin in Windows. When studies and images are purged, the database 
information is also deleted. It helps to ensure that image files and database entries are 
aligned.  
 

 
 
 
To recover purged images from the Windows Recycle Bin, follow these steps. 

1. Open the Recycle Bin in Windows (most often found on the Windows desktop). 
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2. Select the items you want to recover. In the Windows Recycle Bin, studies and 
image objects may not be grouped together, so you need to select all the items 
you want to recover. 

3. Click Restore the selected items. 
4. Open the Onepix Admin and click Database Validation Wizard in the Tools 

menu. When you approve, database records are created for the deleted items. 
5. Follow the instructions in the Database Integrity Control Guide (Database 

Validation Guide). One of the boxes in the control wizard displays images that 
lack the corresponding database entries. Here are the images you want to 
recover. 

6. Click Add Records and continue through the wizard. On the last page, click 
Finish.  

 

SET ACTIVE VIEWSET 

Changes a series layout from inactive to active for multi-layout studies. The layout that 
is currently active has a dark icon. The inactive layout has a gray icon. When switching 
between layouts , consider the number of positions in the different layouts as shown in 
the following examples. 
 
Study below has two layouts. The active layout has 15 images in 26 positions; the 
second (currently inactive) layout has 12 positions. If you choose to change the status 
of the layouts and make it inactive to active, there won't be enough positions in the 
layout with 12 positions.  
 
That would cause 3 of the images to be detched, meaning they would be saved in the 
study but not shown in the current series. To avoid the problem when working with 
multiple layouts , make sure that the second layout (the one you want to make active) 
has enough positions for the number of images in the current series (the one to be 
made inactive). 
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PATIENT/STUDY INFORMATION 

Allows you to change patient and study data. Patient and study information constitutes 
important information in Onepix. Nevertheless, it may sometimes be necessary to 
check it to ensure that the database records are consistent with patient and study 
information. Editing patient information in the data management window makes it 
easy to update and/or clarify patient information in the database.  
Search for the patient in onepix's database via the search tool "binoculars". Select the 
patient in the search results list > select patient information under the edit menu item. 
Changes in patient information are automatically updated through all studies and 
images for the patient. Changes in exam information are updated in the same way.

 
 

 

MOVE OBJECTS 

This feature allows you to combine studies in two different patient records, in case of 
any duplicates of the patient. Combining studies can be an easy way to keep the 
database clean and up to date.  A patient who has married and changed their last name 
is an example of when it may be useful to use the function to merge studies, so that 
the older studies are combined with the newer ones. You can choose to merge all the 
studies for a particular patient, or just the studies you are interested in. In addition to 
merging patients, you can also move individual studies, series and even images from 
one patient to another. 
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To move all studies for a patient, follow these steps: 

1. Start Onepix Admin. Select the search tool "Binoculars" and find the patient 
where the studies will be moved from. 

2. Select the patient's name in the upper right bar. (By selecting the patient, you 
specify which location you want the studies to be moved from.) 

3. Click Edit> Move object.  Select the target patient in the dialog box (the location 
where you want to move the studies). 

4. Click Move to move your studies to the destination location. 

 

To merge some studies/series/images for a specific patient, follow these steps:  

1. Open the Onepix Admin. Select the search tool "Binoculars" and find the patient 
where the studies will be moved from. 

2. Double-click the patient's name in the field in the upper right. (When you see 
the studies for the selected patient, you can then choose which studies 
/series/or images you want to move fromhere.) 

3. Click Edit> Move object.  Select the target patient in the dialog box (the location 
where you want to move the studies). 

4. Click Move to move these to the destination location.  
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UNLOCK EXAM 

A exam/series older then one day will be locked in Onepix 2.0 for all editing. If for some 
reason you need to unlock an exam, then you select the exam in question and choose 
Unlock exam. The exam will automatically return to locked mode the next day. 
 
 
 
 

TOOLS MENU 
 

 
 
 

DATABASE VALIDATION GUIDE 

Checks the data integrity of the patient- and image information stored in the database. 
The Database Integrity Wizard (Validation Wizard) walks you through the following 
control steps: 

- Identifies the location of stored images 
- Identifies image files without corresponding database entries 
- Detects database records without corresponding image files 
- Adds database records for missing image files.  

There may be more than one path or location for image storage in the system, but only 
one path can be checked at a time. When the current path is approved in the wizard, 
images can be identified that are not associated with any corresponding record in the 
database. In that case, you can choose to either delete the images, or add entries for 
the images automatically.  
The wizard also detects if database records are missing. These can be added to the 
database, or removed. 
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SEARCH  

Perform custom searches at the patient, study and image level. The Search dialog box 
offers three different ways to retrieve information in the database: per patient, study, 
or image, using the custom fields in the dialog box. Select either Patients, Study, or 
Images from the drop-down list and enter as much or as little information in the fields 
as you need to filter the results. When you click OK, the information corresponding to 
the search parameters you specified is retrieved. 
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UPDATE THE DATABASE  

Sends a request to the current database to retrieve the latest patient and image 
information. In Onepix, clients and servers act as different programs. Onepix servers 
receive image storage requests and respond to querys and requests for retrieval from 
one or more Onepix clients. Although Onepix clients and servers collaborate in 
exchanging patient, study, and image information, updates to one Onepix client are not 
always visible on other clients, even though they are connected to the same server.  
 
If you click Tools> Update Database, the client retrieves the latest information from the 
server's database. Patient studies are updated on the server at the end of the Onepix 
session. It is important to remember, if the information you are trying to retrieve has 
been added by another Onepix client. To ensure that the information added to a 
particular client is saved in the server database, you need to close the Onepix session 
on the computer in question.   

 

SHOW VOLUMES 

Volume information is saved in the Onepix database to identify paths where images are 
stored in the system. If you need to change the volume information, such as adding, 
modifying, or deleting an image archive, you can do so using the volume editing tool. 

 
 
Keep in mind that changes in volume paths can affect the localization and retrieval of 
images in Onepix. We recommend that you do not make any volume changes without 
the help or instructions of authorized support personnel. 

 

DELETE EMPTY FOLDERS 

Automatically removes empty directories from the image volume.  It remains only to 
select the volume to be processed and click Delete empty folders. 
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OPTIONS MENU 
 

PROPERTIES 

If you select this option, a column is added to the patient/exam/image area with the 
total number of studies for each exam, or the totalnumber of images for each series. 
 

 
 
 

DATABASE 

This can be used to test the connection to the patient database, to view the current 
path to the image folder where the X-ray images are saved, and to configure the 
database. 
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Database connection configuration is done via the Configure Database Connection 
button 
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INSTALLATION MANUAL 

 
 
 
 

INSTALLATION MANUAL 
ENGLISH 
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INSTALLATION OF ONEPIX 
REGISTRERA ONEPIX 
Every Onepix installation needs to be registered in order to meet the traceability 
requirements for medical devices. Fill out the registration form on website onepix.app if you 
have installed Onepix on one or more computers. 

 
SYSTEM REQUIREMENTS 
System requirements for Onepix can be found below. The Onepix application is 
installed with one of the following configurations: Single workstation with Onepix for 
single users (Standalone) or Multi-user network with Onepix (Onepix client/server). For 
Onepix local it is recommended using dedicated servers for storing and downloading 
images. 
 
SECURITY 
To ensure that the security of the system is high, the following is required on the 
computer where Onepix is to be installed: 

- Windows must be updated with the latest Windows updates. 
- Updated and working anti-virus software must be available. 
- Firewall that protects the computer against attacks from the Internet 

CLIENT 
Recommendation for computer: 

- Windows 11, Windows 10 x64, Windows 10 x86 
- CPU 64bit: Intel or AMD Processor 
- 8 GB RAM 
- DirectX 9 or later with WDDM 1.0 or later driver 
- Intel USB chipset 

COMPUTER MONITOR 
Recommendation for screen:  

- A medical monitor (DICOM Monitor) is best suited for displaying X-ray images. 
Alternatively, a monitor of high-quality panel can be used. 

- The screen should ideally be calibrated if this is possible.   
- Minimum resolution is 1280x1024  
- Recommended resolution 1920x1080  
- 24 bit color depth  
- Viewing angle, degrees, 178 

SERVER 
NOTE If there is already a legacy SQL instance, called CDRDICOM, then only the 
database is upgraded, so the existing SQL instance can remain to avoid new 
installation.  When installing in a new environment, the following requirements are 
imposed on the computer: 
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- Windows Server 2022, Windows Server 2016, Windows Server 2012, Windows 
11, Windows 10 x64 

- CPU 64bit: Intel or AMD Processor  
- 8 GB RAM-minne 
- 500 GB hard drive 

REAL WORLD OVERVIEW ONEPIX CLOUD 
 
 

 
 
 

 
REAL WORLD OVERVIEW ONEPIX LOCAL 
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COMPATIBLE HARDWARE 
This table shows compatible hardware that works with Onepix Local, Onepix Cloud and 
in Citrix / Terminal Server environment. Note that Onepix also supports Twain, UVC and 
WIA/WPD acquisition interfaces. Contact the manufacturer for drivers and detailed 
information about which models are compatible with which operating system. 
 

INTRAORAL SENSOR     

Manufacturer Model Connectivit
y 

Onepix 
Local 

Onepix 
Cloud Citrix / TS 

Carestream  
RVG 5100 / 5200 / 6100 
/ 6200 / 6500 

Integrated ✓ ✓ ✓  

Dürr VistaEasy VistaRay sensors  Integrated ✓ ✓ ✓  

Gendex GXPicture GXS-700 Integrated ✓ ✓    

Imagelevel MDX-3 Integrated ✓ ✓ ✓  

KaVo / Dexis SNAPSHOT / DIGORA 
Toto 

Integrated ✓ ✓ ✓  

Myray (iCapture) 
Zen-X / Zen-X E / Zen-X 
DCiS 

TWAIN ✓** ✓** ✓**  

Schick by Sirona 

Schick AE / Schick 33 / 
Schick Elite / XIOS XG 
Select / XIOS XG 
Supreme / CDR Remote 
HS 

Integrated ✓ ✓ ✓  

Schick by Sirona CDR Wireless SDX Integrated ✓* ✓* ✓*  

Schick by Sirona CDR 2000 Integrated ✓* ✓* ✓*  

Vatech EZ Sensor HD Integrated ✓ ✓ ✓**  

Hamamatsu Hamamatsu USB sensor Integrated ✓ ✓    

Planmeca  ProSensor Integrated ✓ ✓ ✓  

Other… 
Sensors that support 
Twain acquisition 

TWAIN ✓** ✓** ✓**  

       

INTRAORAL CAMERA  
    

Manufacturer Model Connectivit
y 

Onepix 
Local 

Onepix 
Cloud 

Citrix / TS  

Acteon Sopro USB cameras Integrated ✓ ✓ ✓  

Carestream CS 1500 Integrated ✓*** ✓*** ✓***  

Dürr VistaEasy VistaCam cameras  Integrated ✓ ✓ ✓  

IC-Lercher 
L-Cam USB – Empia 
Chipset 

Integrated ✓ ✓ ✓  

Myray (iCapture) CU2 Twain ✓** ✓** ✓**  

Schick by Sirona USB Cam4 Integrated ✓ ✓ ✓  

Schick by Sirona USB Cam2 Integrated ✓ ✓ ✓  

Schick by Sirona USB Cam  Integrated ✓* ✓* ✓*  

Vatech Vatech EZCam Integrated ✓*** ✓*** ✓***  

Other… Cameras that support 
UVC 

Integrated ✓*** ✓*** ✓***  
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EXTRAORAL CAMERA      

Manufacturer Model Connectivit
y 

Onepix 
Local 

Onepix 
Cloud 

Citrix / TS  

Fuji Fuji FinepiX S5 Integrated ✓ ✓ ✓  

Nikon 

D7500 / D7200 / D7100 
/ D7000 / D700 / D610 / 
D5100 / D300s / D300 / 
D200 / D90 / D80 

Integrated ✓ ✓ ✓  

Other… 
Cameras that support 
WIA & WPD 

Integrated ✓**** ✓**** ✓****  

       

INTRAORAL IMAGEPLATE SCANNER      

Manufacturer Model 
Connectivit
y 

Onepix 
Local 

Onepix 
Cloud Citrix / TS  

Acteon  PSPIX / PSPIX2 Twain ✓** ✓** ✓**  

Carestream / 
Kodak 

CS 7200 / CS 7400 / CS 
7600 

Integrated ✓ ✓ ✓  

Dürr 
VistaEasy Vistascan / 
Vistascan Mini 

Integrated ✓ ✓ ✓  

Kavo / Dexis 

DIGORA Optime (all 
models) / EXPRESS / 
EXPRESS Origo / KaVo 
Scan eXam / KaVo Scan 
eXam Plus 

Integrated ✓ ✓ ✓  

Innixim  Spark  Integrated ✓      

Vatech Vatech VSP Integrated ✓ ✓** ✓**  

Other… 
Scanners that support 
Twain acquisition 

Twain ✓** ✓** ✓**  

       

PANORAMA / CBCT     

Manufacturer Model Connectivit
y 

Onepix 
Local 

Onepix 
Cloud 

Citrix / TS  

Acteon X-mind Prime (2D) Twain ✓** ✓** ✓**  

Ajat ART Plus (2D) Twain ✓** ✓** ✓**  

Carestream 
CS 8100  / CS 9000  / CS 
9300  (2D) 

Integrated ✓ ✓ ✓  

Myray Hyperion X5 / X9 (2D) Twain ✓** ✓** ✓**  

Kavo / Dexis 

CRANEXTM Novus / 
CRANEXTM Novuse / 
KaVo Pan eXam TM / 
KaVo Pan eXam Plus / 
OP30 / OP200 D / 
OC200 D / OP300 / 
OP300 MaXio  (2D) 

Integrated ✓ ✓ ✓  

Kavo / Dexis 
CRANEX 3D / CRANEX 
3DX / SCANORA 3D / 
SCANORA 3DX 

Integrated ✓    
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Morita 
IC-5 / Veraview Epocs 
(2D) 

Integrated ✓ ✓ ✓  

Planmeca  
DIDAPI & 2D Image 
Capture / ProOne / 
Promax (2D) 

Integrated ✓ ✓ ✓  

Schick by Sirona CDR iPAN (2D) Integrated ✓ ✓ ✓  

Schick by Sirona CDR PanElite (2D) Integrated ✓ ✓ ✓  

Sirona XG3 / XG5 (2D) Twain ✓** ✓** ✓**  

Vatech PaXPrimo (2D) Integrated ✓ ✓ ✓  

Vatech PaXDuo3D Integrated ✓      

Vatech 
VcaptureSW 2D  - PaX-I 
/ GreenX / PaX-I Plus 
(2D) 

Integrated ✓ ✓ ✓  

Vatech VcaptureSW 3D  - 
GreenX / PaX-I Plus 

Integrated ✓      

Other… 
Panorama that support 
Twain acquisition (2D) Twain ✓** ✓** ✓**  

 
* Works only on 32bit Operating systems 
** Image Acquisition is processed with Twain interface provided by the manufacturer. 
*** Cameras that fully support UVC (USB Video Class) are functional with Onepix. 
**** Cameras that support WIA (Windows Image Acquisition) WPD (Windows Portable Devices). 
 
 
 

PRACTICE MANAGEMENT SYSTEMS COMPATIBLE WITH ONEPIX 
The following Practice Management Systems have made integrations to Onepix. 
 
 
  
System Manufacturer 
Al Dente Al Dente Software AS 
Alma  AlmaSoft AB 
Anita  Anita Systems AS 
Carestream T4 Carestream 
Carita Swedish Care 
DentalSuite  Plandent A/S 
Frenda Frenda AB  
Muntra Muntra AB 
Nextsys Unident AB 
Opus  Opus Systemer AS 
Orthodontis  Orthodontis AS 
TD Journal  A-Data A/S 
Zilke  Go On Software 
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SERVER INSTALLATION ONEPIX LOCAL 
 
Onepix Server packages installs the following: 

- SQL server 2022 Express with instance name ONEPIX 
- An empty database is created named OnepixDB 
- Onepix Admin software 

Download Onepix Server and follow the instructions below.  Open the folder where 
Onepix is saved after downloading and run Onepix Server Setup. exe. 
 
Click NEXT 

  
 
The program will automatically find which components need to be installed. But just 
select the boxes that you know for sure you need or don't need to install.  
Klick on NEXT. 
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Read through and tick the License Terms and click NEXT. 

 
 
 
If there is already an older database and a SQL instance installed, such as CDRDICOM, 
then the installation package will not install any new instance, but you will get a dialog 
box where you can fill in the information, test the SQL communication and click Install 
to update the existing database. 
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Wait for the program to finish installing and click Finish. 

 
 

BACKUP ROUTINES 

Onepix database consists of a SQL database named OnepixDB(If you install Onepix 
Server) as well as image volume/volumes containing all imagefiles.  The SQL database is 
an index that shows which image is in which directory and the SQL database can always 
be rebuilt based on the information in the files, but this can take a long time depending 
on how many images there are. In other words, the image volumes contain all the 
information as the files are saved in a so-called DICOM filetype. Our recommendation is 
to always make a backup of all image volumes and the SQL database in order to be able 
to restore it quickly in case of any problems. Which imagevolumes are  used can be 
easily seen by launching the OnepixAdmin program and going to the Tools menu>Show 
Volumes. 

 
Note that it is important to take backup of all volumes even if they are archived as 
changes can occur even in old images. 
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CLIENT INSTALLATION 
 
IMPORTANT INFORMATION 
 
The installation package will automatically uninstall previous CDRDicom and Onepix 
software. Onepix Client package install the following: 

- Onepix client software 
- Onepix Admin software (Optional) 
- Optional plugins such as TWAIN 
- Selectable acquisition modules such as Schick sensor, Kavo Panorama etc. 

Launch the OnepixClient installation package and follow the instructions below. Open 
the folder where Onepix is saved after downloading and run Onepix Client Setup.exe. 
 
 
 
Read through the license agreement, fill in the license approval box and click INSTALL 
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Check the parts you want to be installed and click Install. 

 
 
 
Wait for the program to finish installing and click Finish. 
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INSTALLATION OF ONEPIX CLIENT WITH COMMAND LINE 

To install the program with command line, you can use the following command, for 
example: 

OnepixClient2.3setup.exe 
ADDLOCAL=MainFeature,admin,schicksensor,video,digitalcamera,twain /quiet 

 
Below you will find a table of parameters and what these do. 
* required 
 

Name Gear Description of the switchboard 

Onepix Client ADDLOCAL=MainFeature Install Onepix Client* 

Onepix Admin Admin Install Onepix Admin program 

Access control Security Install Access control tool 

 
Default Acq Modules 

   

Carestream intra-oral carestreamio Install carestream intraoral scanner and sensor support 

Carestream panorama carestreampx Install support for Carestream panorama 

Digital camera digitalcamera Install support for extraoral cameras 

Dürr intra-oral vistaeasy Install support for Dürr intraoral scanner and sensor 

Dürr Camera vistaeasyxc Installing support for Dürr intraoral camera 

E2V e2v Install support for E2V intraoral sensor 

Fuji S5 diticalcamera_old 
Install support for Fuji S5 extraoral camera (old photo 
module) 

Gendex sensor gendexio Install support for Gendex intraoral sensor 

Hamamatsu Hamamatsu Installing support for Hamamtsu intraoral sensor 

Intra-oral camera video Install support for Intraoral cameras 

Kavo intra-oral kavo Install support for Kavo intraoral scanner and sensor 

Kavo panorama kavopx Install support for Kavo panorama 

MDX-3 sensor mdx3 Install support for MDX-3 intraoral X-ray sensor 

Morita panorama morita Install support for Morita panorama 

Planmeca intra-oral planmecaio Install support for Planmeca intraoral sensor 

Planmeca panorama planmecapx Install support for Planmeca panorama 

Schick sensor schick sensor Install support for Schick and Fona sensor 

Schick panorama schickpano Install support for Schick panorama 

Spark scanner spark Install Spark intraoral scanner support 

TWAIN twain Install support for loading from TWAIN sources 

Vatech VSP vatechvsp Install vatech VSP intraoral scanner support 

Vatech sensor vatechio Install vatech intraoral sensor support 
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Vatech panorama vatech Install support for Vatech panorama 

 
Citrix / Terminal Server 

Acquisition Modules 
  

Carestream intra-oral citrixcarestreamio 
Install RSS support for Carestream intraoral scanner and 
sensor 

Carestream panorama citrixcarestreampx Install RSS support for Carestream panorama 

Digital camera citrixdigitalcamera Install RSS support for extraoral cameras 

Dürr intra-oral citrixvistaeasy InstallING RSS support for Dürr intraoral scanner and sensor 

Dürr Camera citrixvistaeasyxc Install RSS support for Dürr intraoral camera 

Fuji S5 citrixphoto 
Install RSS support for Fuji S5 extraoral camera (old photo 
module) 

Hamamatsu citrixhamamatsu Install RSS support for Hamamtsu intraoral sensor 

Intra-oral camera citrixvideonew Install RSS support for Intraoral cameras 

Kavo intra-oral citrixkavo Install RSS support for Kavo intraoral scanner and sensor 

Kavo panorama citrixkavopx Install RSS support for Kavo panorama 

MDX-3 sensor citrixmdx3 Installing RSS support for MDX-3 intraoral X-ray sensor 

Morita panorama citrixmorita Install RSS support for Morita panorama 

Planmeca intra-oral citrixplanmecaio Install RSS support for Planmeca intraoral sensor 

Planmeca panorama citrixplanmecapx Install RSS support for Planmeca panorama 

Schick sensor citrixschick sensor Install RSS support for Schick and Fona sensor 

Schick panorama citrixschickpano Install RSS support for Schick panorama 

TWAIN citrixtwain Install RSS support for loading from TWAIN sources 

Vatech sensor citrixvatechio Install RSS support for Vatech intraoral sensor 

Vatech panorama citrixvatechpano Install RSS support for Vatech panorama 

 
Plugin - General 

  

CBCT Plugin cbct Install plugin for CBCT (3D viewer) 

Facad Plugin facadplugin Install plugin for exporting images from Onepix to Facad 

Logviewer logviewer Install software to be able to read Onepix logging 

Pacs Export Plugin pacsexportplugin Install plugin for exporting images from Onepix to Pacs 

STL Import Plugin stlimport Install plugin for STL import 

3 Shape Unite Plugin _3shapeunite Install plugin for 3 Shape Unite 

 
Plugin - Citrix 

  

Import plugin citriximport plugin Import plugin for Citrix / Terminal server 

 
Extra   

 /quiet Silent installation without graphical interface 
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LICENSE ACTIVATION ONEPIX LOCAL 

The first time you start Onepix, you will receive a request to activate Onepix. Fill in all 
the details and click Activate product. You can also startt a 30-day trial if you don't have 
a license code. When the evaluation period ends, you will not be able to start Onepix 
without registering with a license code. 
 

 
Warning 
Do not take any odontological images in Demo mode unless you have ensured that you 
have a software that can display DICOM images after the function has ended! 
 

 
 
ONLINE ACTIVATION 
Fill in all the details and click Activate Product. 

 
 
OFFLINE ACTIVATION 
If, for some reason, your computer is not connected to the internet and is offline. Then 
you will get the following information in the activation dialog box. Click Offline 
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Activation to activate the license anyway. Please note that in order for you to activate 
the license offline, you must have access to the internet on another computer.  

 
Fill in all the details and click Activate Product. 

 
 

You will receive this information when you click activate product, follow the 
instructions below to activate your license. You must have access to a computer with 
an internet connection in order to do this.  
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LICENSE ACTIVATION WITH COMMAND LINE ONEPIX LOCAL 

In cases where you need to activate / deactivate Onepix with command line, you can 
do this with the software opxlicense.exe located in the directory C:\Program Files 
(x86)\Unident AB\Onepix. 

- Activation command: opxlicense.exe /a XXXXXXXXXXXXXXXXXX /f Name /l 
Surname /c Company /e test@unident.se 

- Deactivation command: opxlicense.exe /d XXXXXXXXXXXXXXXXXX 

 

LICENSE ACTIVATION VIA PROXY 
If proxy is used, then proxy settings can be put in the following format. 

- Activation command: opxlicense.exe /a XXXXXXXXXXXXXXXXXX /f Name /l 
Surname /c Company /e test@unident.se /pi 127.0.0.1 /pn 1080 /pu adminuser 
/pp password 

- Deactivation command: opxlicense.exe /d XXXXXXXXXXXXXXXXXX /pi 127.0.0.1 
/pn 1080 /pu adminuser /pp password 

 

DESCRIPTION OF COMMANDS 
 

Name Gear 

/a Activate license code 

/d Deactivating license code 

/f First name * 

/l Surname * 

/c Company * 

/e Email 

/pi Proxy IP 

/pn Proxy port number 

/pu Proxy users 

/pp Proxy password 

 
* Use "quotation marks" if there is a space in the entered value, e.g. "Unident AB" 

 

DATABASE CONNECTION 
To connect onepix Client to an existing database on the computer or network, do the 
following. If the SQL instance/database is created manually, i.e. is not installed via 
Onepix Server then you can connect to it by ticking "Show advanced options" instead 
and filling in the required details. 
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OPTION 1 - WINDOWS LOGIN 

- Immediately after installation, launch the Onepix client by double-clicking on 
the shortcut on the desktop. The Configure Database Connection dialog box 
appears. If you can't get the dialog box, you can always go into Onepix Admin 
and go via the Options menu>Database 

- If you are going to connect to an external server (for example, if your images 
are saved on a computer other than the one you are sitting at), click the down 
arrow and select the correct server from the list. 

- Check the option "Connect with my Windows login credentials". 
- Click the Test Connection button. 
- If the connection works, click OK. The installation is now complete.  
- If the connection doesn't work, continue with option 2. 

 

 
 
 
OPTION 2 - SQL LOGIN 

- Uncheck the "Connect with my Windows login credentials" option.  
- Enter "opx" (in lower case and without quotation marks) as the username and 

password. 
- Click the Test Connection button. Click OK when the connection is working. 
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-  
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ONEPIXAUTOMATION - PATIENT MANAGEMENT SYSTEM INTEGRATION 
Most patient management systems have a direct integration with Onepix. For those 
systems that lack a direct integration but still can start external programs through 
sending parameters, you can use OnepixAutomation.exe. OnepixAutomation.exe is 
installed automatically and is located in the same folder as OnepixClient.exe, the 
command should look like the example below:  

Example: OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 

This is only an example so PatientID, Lastname and Firstname should be changed to the 
corresponding parameters from the individual patient management system. Quotation 
marks should be used to include all patient information, such as if the patient is 
registered with more than one first name or last name in the patient management 
system. 
 
 
LOCKED FEATURES 
Via Onepix Automation, you have the opportunity to lock functions in Onepix if for 
example, you do not want ordinary users to be able to search for or create new 
patients directly in Onepix, or if you want to lock settings for users. Each suspended 
feature in Onepix has a flag as shown below with an associated value: 

o SEARCH PATIENT - (DisableOpen) = 1 
o NEW LAYOUT/SERIES - (DisableNewLayout) = 2 
o SETTINGS - (DisableSettings) = 4 
o NEW EXAM - (DisableNewExam) = 8 
o NEW SERIES - (DisableNewSeries) = 16 
o NEW PATIENT - (DisableNewPatient) = 32 

 
To combine the block of two or more functions, add the numbers from the flags and 
enter the sum at the end. Below are 2 examples of how it works: 

1. Run OnepixAutomation with the command below to lock SEARCH PATIENT: 
OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 1 

2. Run OnepixAutomation with the command below to lock SEARCH PATIENT + 
NEW LAYOUT + SETTINGS + NEW PATIENT: 
OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 39 

 
 
SELECTABLE PARAMETERS 
If you want to include the dentist's information "Dentist" and/or clinic name "Clinic" 
then you add these at the end according to the example below: 

   OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 39 "Dentist" "Clinic" 

 
AUTOMATIC UPDATING OF PATIENT DATA 
If it is possible to send parameters with a unique ID from the Patient Management 
System, then you can use these to update the patient data automatically when you 
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open the patient from the Patient Management System.  The unique ID parameter 
should be passed at the end, here are examples: 

-  OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 39 "Dentist" 
"Clinic" "UniqueID" 

If you want to skip certain parameters such as Dentist and Clinic , you write like this: 

-  OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 39 "" "" "UniqueID" 

Note that "" quotation marks record  skipping that parameter. 
 
It is important to keep in mind that the unique ID should be as unique as possible. Since 
images can be sent to other clinics, you want to avoid that the uniqueID collides in 
another database.  To avoid this,  you can for example send several parameters from 
the journal at the same time such as clinic name, therapist and patient ID directly after 
each other as long as these are within the "" quotation marks. 
 
Example: 

- OnepixAutomation.exe "PatientID" "Lastname" "Firstname" 39 "" "" 
"ClinicDentistUniqueID"  
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ONEPIX LOG VIEWER 
 
From Onepix version 2.3, all activity is logged in the same database as the images. In  
other words, no separate installations are required for activity logging.  Logging takes 
place in the database table named Audit where the following activity is saved: 

- Login 
- Logout 
- Open patient 
- Move Exam 
- Move Series 
- Move Image 
- Delete Exam 
- Delete Series 
- New Exam 
- New Series 
- New Image 
- Export Image 
- Open Image 
- Modify Image 
- Detach Image 
- Attach Image 

 
To be able to access the log, you can install the program Onepix Log Viewer by checking 
Log Viewer during the installation process. 
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The program is installed in the same directory as OnepixClient and a shortcut is created 
on the desktop.  
 
To take part of the information that is logged in the Audit table, launch the Onepix Log 
Viewer program.  Here you can search for Patient (PatientID/Social Security Number), 
User(Windows username), or Computer name.  
 

 
 
The result can be exported in CSV format that can be opened in an external text editor 
if desired. 
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ONEPIX SECURITY EDITOR ONEPIX LOCAL 
 
With Security Editor you can restrict access to functions that can be controlled by 
assigning Windows users a permission level: Low, Medium, or High.  
 

 
 
Security Editor is installed using the Onepix client package. A shortcut to the program is 
installed on the desktop. 

 
 
The database is updated with the dbo tables. SecurityRole and dbo. SIDToSecurityRole, 
these tables should be assigned the following rights for all users connecting to the 
database: SELECT.  Administrators should be granted the following rights: ALTER, 
SELECT, INSERT, UPDATE, DELETE 
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To add users, click the Add User/Group button. Search for a user or group in your 
domain. Select the entry in the result, select a permission level, and click the Add 
button.      

 
 
The permission levels Low, Medium, and High can be edited by right-clicking on each 
level and selecting Modify. 

 
 
Here are examples of low security permissions. 
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To change/delete the user/group list, right-click the user/group and select Edit or 
Delete. 

 
 
To Edit, select a permission level from the list and click Ok 
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INSTALLATION RSS CLIENT 5.4.1 ONEPIX LOCAL 
 
GET TO KNOW ONEPIX RSS 

 
 
 
 
The Onepix RSS client communicates with Onepix on port 27016 (TCP). This means 
that this port must be open between the Onepix client and the Onepix RSS client for 
the system to work. 
 
Even if the client PC does not have the Onepix RSS client installed, this port must be 
open if Onepix is to be used for image review from the client PC. If the port isn’t open, 
Onepix will need about 30 seconds per module to start at startup. This can take a long 
time depending on how many modules are installed. 
 
 

INSTALLATION REQUIREMENTS RSSCLIENT 
This installation assumes that Onepix 2.1 or later is installed on the Citrixserver / 
Terminalserver. Read more about this under the installation section of the Onepix user 
manual. It also assumes that the Onepix client is started once to test functionality and 
that the connection to the database and image storage works.  Client computer 
requirements: 

- Windows 7 32/64bit, Windows 8.1 32/64bit, Windows 10 32/64bit 
- RSS Client requires .NET Framework 4.6.1 or later to work. 
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REAL WORLD OVERVIEW ONEPIX LOCAL TS OR CITRIX ENVIRONMENT 
 

 
 

INSTALLATION OF ONEPIX CLIENT ON CITRIX / TERMINAL SERVER 

Support for acquisition in Citrix / Terminal Server is now installed with the same 
installation package as the Onepix client. Use a installation package of Onepix 2.1 or 
later.  
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Select the acquisition modules to use, it is important to select the Citrix, RDP 
acquisition mode and click Install. Launch the Onepix client once to set up the database 
connection as well as activate the license code. 
 
NOTE In order to use Onepix in the Citrix/Terminal Server environment, a "Remote" 
license is required. Read more about this under the installation section of the Onepix 
user manual. 

 

INSTALLATION OF ONEPIX RSS CLIENT ON CLIENTCOMPUTER/THIN CLIENT 

Run OnepixRSSClient5.4. 1_x86.msi or OnepixRSSClient5.4. 1_x64.msi 

Click Next to continue the installation. 

 
 
Click I accept...  and then click Next. 

 
 
Click Install to start the installation. 
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Click Finish. 

 
 
 

 
Onepix RSS Client requires a reboot after installation. This is in order for the Onepix RSS 
Client process to be started, as the shortcut to the process can be found under 
Autostart in the Start menu. Click Yes to restart the computer. 
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INSTALLATION OF DRIVERS 

The Onepix RSS Client 5.4.0 package already contains following drivers to maintain 
backward compatibility. Those that have (x86) at the end, only works on 32bit OS and 
are only available in OnepixRSSClientx86.msi package. 

- Schick CDR 2000 USB Remote (x86) 
- Schick CDR 2000 USB Remote HS 
- Schick CDR Wireless (x86) 
- Schick CDR Elite 
- Schick 33 
- Schick USBCam (x86) 
- Schick USBCam2 x(x86) 
- Schick USBCam4 
- Schick Pan-X (x86) 
- Schick iPan (x86) 

All other hardware requires separate installation of drivers, these can be found on 
www.onepix.se/drivrutiner 
 
 
CONFIGURATION OF ACQUISITION MODULES IN ONEPIX RSS 
Configuration of the various acquisition modules used on the local client is controlled 
via XML files. These files are centrally managed from the servers and are automatically 
installed in the C:\[ProgramData]\Schick Technologies\CDR\ModuleConfigs directory, 
but can be moved to any location.  
 
If you move these files and directories to another location, change the path in the 
registry on the Citrix/RDP server in the key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Unident AB\RSS\ConfigPath. 
 
[ConfigPath] contains the files that determine the default configuration for all 
connected clients. The files that should be located here are: Importplugin.xml, 
Pano.xml, PanoVatech.xml, Photo.xml, SynergyUSB.xml, TwainPlugin, Video.xml, 
Xray.xml. 
 
After installation, there is also a file called wireless.xml.example. This is an example file 
that shows what the wireless sensor registration file should look like. This should be 
placed in each client's directory under [Configpath], renamed wireless.xml in the cases 
where wireless Schick sensors are used. 
 

CUSTOM CONFIGURATION CLIENT 

When a client should have a configuration that is different from the default 
configuration, create a folder under "ConfigPath" and name it after the client computer 
name. Then copy in the XML files that this client needs (depends on the features the 
client will use) and make the required changes to the files. 
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In order for the clients running Onepix RSS to load the settings from the server, an 
empty file named "loadmodules" must be in the client's directory. 
 

CENTRALLY STORED CALIBRATION FILES FOR SENSORS 

Onepix RSS has a function that goes out and retrieves the calibration file that the client 
needs from a central location and puts it locally on the computer. This is done to speed 
up the image capture process. 
 
The path to the calibration files is set in the registry of the terminal server of the key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Unident AB\RSS\CalibPath 
 
This does not apply to CDR Elite, Schick33 as well as Fona sensors, which have the 
calibration file built into the sensor and are calibrated automatically. 
 

SETTINGS IN XML FILES 

- Import plugin.xml 
Here settings are made for Card Import, the function of loading images to 
Onepix from memory cards or other folder. 

- OnepixPhoto.xml 
New photo module that supports system cameras that have WIA support. 
Setting are made here for the new photo module. 

- Pano.xml 
Here settings are made for panoramic machines from Schick Technologies. The 
machine models that are compatible are: CDR-Pan, CDR-PanX and iPan. 

- PanoVatech.xml 
Here the choice of machine model is made. The machines you can choose from 
are annotated in the XML file. 

- Photo.xml (Old photo module, remains for Fuji S5 support) 
Here settings are made for direct shooting of images into Onepix with extraoral 
camera. The camera models that are compatible are: Fuji S2, S3, S5. Nikon D90, 
D200, D300, D300S, D700.  

- Video.xml 
This file is included for support for Intraoral cameras from Schick Technologies. 
The cameras that are compatible are USBCam1, USBCam2 and USBCam4.  No 
settings need to be made in this file. 

- Xray.xml 
Here general settings for sensors from Schick Technologies are made. The 
sensors that are compatible are: CDR 2000, CDR Wireless, CDR Elite, Schick 33. 

- SynergyUSB.xml 
This is where the resolution of the Schick 33 sensor is set. 

 



 
 
 

135 
 

 
CONTENTS OF THE IMPORT PLUGIN.XML 
Here it is set which compression and size to choose when card import is used. The user 
can change this manually, but every time the card import is started again, it returns to 
the set standard.  
 
Default XML file 
<!-- 
Compression levels:  
0 = "Uncompressed" 
1 = "High (2:1)" 
2 = "Medium (5:1)" 
3 = "Low (20:1)" 
 
DefaultSize: 
0 = "Small (1MP)" 
1 = "Normal (2MP)" 
2 = "Large (4MP)" 
3 = "Very Large (6MP)" 
 
--> 
<?xml version='1.0' encoding='utf-8'?> 
<settings> 
 <key name="DefaultCompression" type="DWORD">3</key> 
 <key name="DefaultSize" type="DWORD">1</key> 
</settings> 
 
 
ONEPIXPHOTO CONTENT.XML 
Here you can set the size used on photos that are loaded via the digital camera 
module. 
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings> 
<!-- 
ImageSize: 
    0"Small (1MP)"  
    1 "Normal (2MP)" 
    2 "Large (4MP)" 
    3 "Very large (6MP)" 
  
-->  
<key name="imageSize" type="string">0</key> 
</settings> 
 
 
CONTENT OF PANO.XML 
The most common changes made here are to set the 12 bit acquisitionmode to 1 or 0. 
It is done by setting "ACQUIRE_12BITS" to 1 (12 bits) or 0 (8 bits) 
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Keep in mind here that the path to calibration files should not be central because the 
panoramic calibration file is not always unique and requires calibration on the client. 
DEVICE indicates the device used. Type "CDR-320" if you want to use the CDRPan 
sensor that uses PCI cards. Type "iPAN.SYS" if you want to use the iPAN sensor that has 
a USB interface. Type "PanElite.SYS" if you want to use PanElite Panorama/Kefalostat.  
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings>  
 <key name="Acquire_12Bits" type="boolean">0</key> 
 <key name="Auto_ACCEPT" type="boolean">1</key> 
 <key name="Auto_Count" type="numerical">40</key> 
 <key name="Auto_Thresh" type="numerical">15</key> 
 <key name="Blanks" type="numerical">3</key> 
 <key name="Calibrate" type="boolean">1</key> 
 <key name="Clip_Saturated" type="boolean">1</key> 
 <key name="Dark_Sub" type="boolean">1</key> 
 <key name="Dark_Thresh" type="numerical">99</key> 
 <key name="Device" type="string">iPAN.SYS</key> 
 <key name="DeviceDll" type="string">PanoAcq.dll</key> 
 <key name="direction" type="numerical">0</key> 
 <key name="Eq_Thresh" type="numerical">9950</key> 
 <key name="Equalize" type="boolean">0</key> 
 <key name="Extra_Bad_Rows" type="boolean">0</key> 
 <key name="Initial_Timeout" type="numerical">60</key> 
 <key name="Lx" type="numerical">3200</key> 
 <key name="Ly" type="numerical">1603</key> 
 <key name="MapAutoThresh" type="boolean">0</key> 
 <key name="Mapping" type="numerical">1</key> 
 <key name="Nonlinear" type="boolean">1</key> 
 <key name="Spot_Remover" type="boolean">0</key> 
 <key name="Stop_Timeout" type="numerical">7</key> 
 <key name="System_Path" type="string">C:\\Program Files\\Schick 
Technologies\\Shared Files\\</key> 
 <key name="Thresh" type="numerical">99</key> 
</settings>  
 
 
CONTENT OF PANOVATECH.XML 
The following Vatech models are compatible: Pax-PnP, Pax-Primo, Pax-500VS • Pax-
Uni3D, Picasso Trio, Pax-Reve3D, Pax-Duo3D, Pax-Flex3D and VCaptureSW compatible 
models.  Under the key "DeviceType" it is defined which model is used. 
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings> 
<!-- 
 devicetypes: 
 5=PnP 
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 16=PAXUni3D_NP 
 17=PAXUni3D_NC 
 18=PAXUni3D_SP 
 19=PAXUni3D_SC, 
 22=Picasso Trio 
 23=Picasso Pro 
 24=Picasso Master 
 25=PAXReve3D 
 26=PAXPrimo 
 30=VCaptureSW (Pax-i, Pax-i3D, Pax-i-3D Green, Pax-Insight, Pax-Flex3D)  
-->  
 <key name="DeviceType" type="DWORD">30</key> 
 <key name="Debug" type="DWORD">0</key> 
</settings> 
 
 
CONTENT OF PHOTO.XML 
Campath specifies a direct path to the folder where a digital camera can directly store 
images. CamType 0=Fuji Finepix S2/S3, CamType 1= Nikon D90, D200, D300, D300S, 
D5100, D610, D700, D7000, D7100, D7200, D7500 or Fuji Finepix S5.  Camtype 2= 
Direct-connected digital camera. D1 set to 1 deletes the images in the directly 
connected digital camera folder. 
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings>  
 <key name="CamPath" type="SZ"> </key> 
 <key name="CamType" type="DWORD">1</key> 
 <key name="d0" type="DWORD">1</key> 
 <key name="d1" type="DWORD">0</key> 
 <key name="d2" type="DWORD">0</key> 
<!-- 
ImageSize: 
    0 "Small (1MP)"  
    1 "Normal (2MP)" 
    2 "Large (4MP)" 
    3 "Very large (6MP)" 
--> 
 <key name="ImageSize" type="DWORD">0</key> 
</settings> 
 
CONTENT IN VIDEO.XML 
If an older version of the Schick intraoral camera is used, this can be configured here. 
For Schick USBCamX , nothing needs to be changed. 
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings>  
 <key name="AutoWhite" type="numerical">1</key> 
 <key name="CamPort" type="numerical">320</key> 
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 <key name="LightSource" type="numerical">1</key> 
 <key name="Mode" type="numerical">0</key> 
 <key name="UseCamera" type="numerical">0</key> 
</settings> 
 
 
CONTENT OF XRAY.XML 
DEVICE indicates which sensor is used.  

USBCDR.SYS = CDR2000 USB Remote (black) 
CDRUSB2.DLL = CDR USB Remote HS (white) 
SynergyUSB.DLL = CDR Elite, Schick 33 
USBCDRW.SYS = Wireless 2 
USBCDRSDX.SYS = Wireless SDX. 

 
DEVICEDLL should be ACQ32.DLL for all sensors except CDR Elite and Schick 33 where it 
should be SynergyACQ.dll. 
To configure filters (ONLY FOR CDR ELITE), apply_postprocess  must be set to 1.  Filters 
are then set using POST_PROCESS_LEVEL: 

1 = smooth  
2 = edge low  
3 = edge high  
0 = none  

 
To apply 12 bits of grayscale to the X-ray images, ACQUIRE_12BITS should  be set to 1. 
There is also the option to disable the CDR Wireless base station when Onepix starts.  
Base_Disabled should then be set at value 1. 
 
SYSTEM_PATH is the local path to the sensor calibration file. This differs depending on 
the operating system: 

- Windows XP - C:\Documents and Settings\All Users\Application Data\Schick 
Technologies\CDR\Sensors\ 

- Windows Vista/7/8/10 - C:\ProgramData\Schick Technologies\CDR\Sensors\ 

 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings>  
 <key name="ACQUIRE_12BITS" type="numerical">1</key> 
 <key name="AUTO_ACCEPT" type="numerical">1</key> 
 <key name="AUTO_COUNT" type="numerical">40</key> 
 <key name="AUTO_THRESH" type="numerical">15</key> 
 <key name="CALIBRATE" type="numerical">1</key> 
 <key name="DARK_SUB" type="numerical">1</key> 
 <key name="DEVICE" type="string">SynergyUSB.DLL</key> 
 <key name="DEVICEDLL" type="string">SynergyACQ.DLL</key>  
 <key name="USB_AUTODETECT" type="boolean">0</key>  
 <key name="apply_postprocess" type="boolean">0</key>  
 <key name="POST_PROCESS_LEVEL" type="numerical">0</key> 
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 <key name="DynamicRangeMsg" type="numerical">0</key> 
 <key name="EQ_MIN_COUNT" type="numerical">9999</key> 
 <key name="EQ_THRESH" type="numerical">9950</key> 
 <key name="EQ_THRESH0" type="numerical">0</key> 
 <key name="EQUALIZE" type="numerical">0</key> 
 <key name="EXP_TIME" type="numerical">15</key> 
 <key name="FOOTPEDAL" type="numerical">0</key> 
 <key name="FOOTPEDAL_ACTIVE" type="numerical">0</key> 
 <key name="FOOTPEDAL_COM" type="numerical">1</key> 
 <key name="GENERATE_PATID" type="numerical">0</key> 
 <key name="INTEGRATE_TIME" type="numerical">7</key> 
 <key name="MapAutoThresh" type="numerical">0</key> 
 <key name="Mapping" type="numerical">1</key> 
 <key name="NON_LINEAR" type="numerical">1</key> 
 <key name="PHOENIX_INTEGRATE_TIME" type="numerical">7</key> 
 <key name="PORT" type="numerical">768</key> 
 <key name="RAMPUP" type="numerical">8</key> 
 <key name="RAMPUP_IMG" type="numerical">6</key> 
 <key name="RESET_DURATION" type="numerical">410</key> 
 <key name="SERIES_FLIP" type="numerical">0</key> 
 <key name="SPOT_REMOVER" type="numerical">0</key> 
 <key name="SYSTEM_PATH" type="string">C:\\Documents and Settings\\All 
Users\\Application Data\\Schick Technologies\\CDR\\Sensors\\</key> 
 <key name="BASE_DISABLED" type="numerical">0</key> 
</settings> 
 
 
CONTENT IN SYNERGYUSB.XML 
Here you set which resolution to use when acquiring with Schick 33 sensors. 
MAXIMUS_BINNED_MODE set to value 1, provides high resolution. Value 2 provides 
standard resolution. 
 
Default XML file 
<?xml version='1.0' encoding='utf-8'?> 
<settings>  
 <key name="MAXIMUS_BINNED_MODE" type="numerical">1</key> 
</settings> 
 
 

FUNCTIONAL CHECK 
The following section describes how to perform a functional check of all modules after 
installing and configuring Onepix with Onepix RSS. 
 
CARD IMPORT TEST 
For this step you need a memory card with pictures and the memory card reader 
connected to a computer with the RSS client installed.  

1. Insert a memory card into the card reader or plug in the camera with USB cable 
and turn on the camera. 
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2. Open a test patient in Onepix.  
3. To create a new series, click NEW SERIES or NEW EXAM. Then select a series, 

e.g. CAMERA SERIES.  
4. Click the "IMPORT" button to the right of the series. The images on the memory 

card should now appear in the preview box.  
5. If you don't have any pictures on the card, you can select "Browse" to find the 

images locally on the computer.   
6. When the images appear in the preview, click "IMPORT" to start importing the 

images into Onepix. The images shall now be displayed in Onepix after a 
moment. 

 
IMAGE ACQUISITION TEST 
Image acquisition is done in the same way no matter what hardware you choose, here 
are examples of how image acquisition can be done with X-ray sensor, photo or 
intraoral camera. For more information on image acquisition/imaging see the Onepix 
user manual. 
 
X-ray sensor 
For this step you need to have access to an X-ray tube, a sensor connected to the 
USBRemote box and a computer with the RSS client installed.   

1. Open a test patient in Onepix via the "SEARCH PATIENT" function.  
2. Create a new series by clicking NEW EXAM or NEW SERIES. Then select an X-ray 

series, e.g. HORIZONTAL BITEWING. 
3. Make the sensor ready for image capture by clicking the +START symbol in an 

empty position or pressing the CTRL+T keys. The highlighted position on the 
screen should now light up green. 

4. The sensor is now ready to be exposed with the X-ray machine. Feel free to 
place an object between the active surface of the sensor (flat side) and the X-
ray tube.  Please leave this to a nurse who knows how the X-ray machine works. 

5. The image should now after a short time appear on the screen in Onepix. 

 
Photo camera/Intraoral camera 
For this step you need access to a system camera or an intraoral camera that is 
supported according to the compatibility list and a computer with the RSS client 
installed is needed.   

1. Open a test patient in Onepix via the "SEARCH PATIENT" function.  
2. Create a new series by clicking NEW EXAM or NEW SERIES. Then select a 

Camera series. 
3. Get the camera ready for shooting by clicking the +START symbol in an empty 

position. The highlighted position on the screen should now light up green. (If 
it's an intraoral camera, then a preview window opens.)  
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4. Take a picture with the photo camera. (With intraoral camera, freeze an image 
and click the “Take Picture” button) 

5. The image should now after a short time appear on the screen in Onepix. 

 
 

CLIENT AND SERVER TROUBLESHOOTING 
Server-side errors are logged under %APPDATA%\Unident AB\Onepix\Logs\ and on the 
RSS client side under %APPDATA%\Unident AB\RSS\. 
 
If the client does not have contact, first check that the process "RssClient.exe" is 
running on the client. The processes are displayed in the Task Manager. If the process 
is not running, start RSSClient by running "RSSClient.exe" located at the following path: 
C:\Program Files\Unident AB\RssClient\. 
 
The RSSClient process is started when Windows starts by being located in Autostart in 
the Start Menu. This process requires Microsoft .NET 4.6.1 installed to start. 
 
If it still doesn't work, check that RSS is installed and that it is the correct version that is 
installed. Make sure you have followed the instructions in this document for 
configuring RSS and Onepix. 


